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This book is for anyone involved in creating documentation for Construction whether 
architect, builder, engineer, interior designer or DIY enthusiast. 

It is recommended that the user should become familiar with SketchUp’s tools and 
concepts before attempting the exercises in this book. While the lessons are quite self-
contained, familiarity with modelling, navigating the model space, and model 
management is strongly advised. For excellent advice and links to further resources 
to help you regarding this, please visit the Resources Section on 
www.SketchUp.Expert

WHO SHOULD USE THIS MANUAL?

WHAT DO I NEED TO COMPLETE THIS COURSE?

To make use of this book, you’ll need access to SketchUp Pro 2019 or later. A modern 
laptop or desktop computer running Windows 7+ or later MacOS X.12 or newer is required 
to run the software. There are also hardware requirements that you should be aware of. 

Hardware and software requirements are available on the SketchUp website.

 https://help.sketchup.com/en/sketchup/sketchup-hardware-and-software-
requirements

You’ll need an internet connection to download the files that go with this book- (See Link on 
Page 4.)

http://www.SketchUp.Expert
https://help.sketchup.com/en/sketchup/sketchup-hardware-and-software-requirements
https://help.sketchup.com/en/sketchup/sketchup-hardware-and-software-requirements


Contents Page

CONSTRUCTION DOCUMENTS USING SKETCHUP PRO 2020

 Copyright Paul J. Lee 2020

CONTENTS

Contents Page No.   
Who should use this book?    
Contents    
Why SketchUp?    
SketchUp & BIM    
Introduction 1   
Getting Started 2   
Drawing Construction Lines 3   
Drawing The Plan 4 – 19   
 5   
Creating Groups & Layers 20 – 22   
Modelling the House 23 – 54   
  Shortcut No. 1: Hide 26
  Structuring Your Model 30 – 31
  Fixing Geometry 34
  Shortcut No. 2: Colour by Axis 45
The Section Toolbar 56   
Setting Up Your Drawings 57 – 79   
  Shortcut No. 3: Previous Views 80
House Model- FinishUp 1 80 – 91   
  Shortcut No. 4: Paste in Place 84
  Shortcut No. 5: Toggle Perspective 85
    
Modelling Details 92 – 98   
Drawing Production - LayOut 99 – 102   
LayOut: Dimensions 103 – 104   
LayOut: Shapes & Infill 105   
LayOut: Text 106 – 107   
LayOut: Sheet Organisation 108   
LayOut: Model Settings 109   
LayOut: Scaled Drawing 110   
LayOut: Pages & Layers 111   
LayOut: Finishing Sheets 1 112   
LayOut: Scrapbook 113   
LayOut: Finishing Sheets 2 114   
LayOut: Details 115   
Modelling – FinishUp 116   
Acknowledgments & Thanks 117   



Why SketchUp? Page

CONSTRUCTION DOCUMENTS USING SKETCHUP PRO 2020

 Copyright Paul J. Lee 2020

SketchUp delivers an efficient 3D model that provides updatable drawings directly from 
the model. 2D CAD 

Figuring Out
Section

Orienting
Sections

Aligning and 
orienting Elevations

Ligning up
overlapping plans

Grid Lines often
required for 
drawing guidance

Your only visible area
Requires constant zooming, 
panning around the drawings to 
check for alignment and accuracy.

Drawings are
always inconsistent/
conflicting. Which one
is correct?

WHY IS SKETCHUP BETTER THAN 2D CAD?

Reading drawings
on top of  each other
to match them up

TYPICAL CAD REQUIREMENTS

Plans 2 Drawings
Sections 2 Drawings
Elevations 4 Drawings
Roof  Plan 1 Drawing
Site Plan 1 Drawing

Total Output 10 Drawings
0 Perspectives
Multiple Potential Drawing Errors

Orienting 
Elevations2D CAD

SKETCHUP
SketchUp has none 
of  the above issues

Model & 
Section Cuts

Drawings

Editing requires 
changes and 

coordination with 
multiple drawings.

Editing is quick and automatically 
updates all drawings.

Dynamic 
Updates
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SketchUp's unique blend of user friendliness, flexibility and extendability means that it 

has quite an unlimited potential as a BIM tool.

Facility modelled in SketchUp using BIM functionality (Attribution: sketchupitalia.it)

While certain tasks are handled better by other platforms, they are limited to a particular 

speciality. Not so with SketchUp, which can be used for a myriad of purposes. For 

example:

• 3D virtual tours
• Construction sequencing
• Cost reports and analysis
• Energy analysis/ strategy appraisal
• Photographic Renders (with extensions)
• Clash Detection
• Online Collaboration
• Component Cataloguing
• Parametric Modelling
• IFC Classification
• Construction Documentation (CAD)
• Open Program Interface (Extendability)
• Shadow studies

This list is by no means exhaustive.

SketchUp is not hampered by large file sizes or complex automated ("Parametric") 

components. Modelling an object doesn’t require programming an object or looking at a 

dialogue box. Sharing files is instantaneous. SketchUp Pro is used as a BIM tool by 

both small and large organisations ranging from one-man operations to multinationals 

either as a complete business solution or part of a set of tools.

See SketchUp.Expert Resources for Examples of  SketchUp for BIM in action:

• Mortenson Construction: SketchUp Pro in construction - video case study

• Barton Malow 3D for Construction: delivering quality & efficiency

• McCarthy Building Company: Case Study

Find out more about SketchUp for BIM at the Resources section on 
www.SketchUp.Expert

SKETCHUP AND BIM

http://www.SketchUp.Expert
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This is the second version of the book entitled "Construction Documents Using SketchUp Pro & LayOut." 

which was released in October 2012 as a digital download from Sketchucation.com. It was the first book 

ever released on the topic of producing Construction Documents from SketchUp Pro. Since that time a 

number of great titles have been published by other authors around the same topic. Following the digital 

rollout, this book was published in paper format in 2013 on Createspace (Now Kindle Direct.) A lot has 

happened with SketchUp since the book’s release. There have been some excellent improvements in the 

software, tools and plugins. This update is well overdue.

This course is a practical step by step course showing you how a building model is created and organised. 

First I’ll show you what we're going to build, then we’ll go back to start to building it from scratch.

The project I’ve selected for these 

training exercises is a small home 

refit/ extension that I designed and 

project managed in 2011. The 

location is a suburb of Cork City, 

Ireland. I selected this project 

because it’s small in size but 

reasonably complex- presenting us 

with a worthwhile learning 

opportunity. 

TECHNICAL DESCRIPTION

All interior walls were demolished except for the central structural 

wall which supports the roof. Existing floors and walls were 

upgraded and timberframe extensions were added to the East and 

South. The new plan exploits the split level of the site, creating a 

generously-sized sun room to the East facing garden.

I’ve been teaching SketchUp since 2008 and having tried out 

different approaches I’ve found the “dive-in-first” to be the best- 

Building starts immediately and then after a while we review what 

we’ve been doing- We’re ready for a little bit of theory. After 

looking at some tools and settings we continue building some more 

and then review again etc. At the end we finish with tangible 

assets: A set of 3D models and drawings that look great in your 

portfolio. 

I hope you’ll enjoy this course and hope that SketchUp brings 

benefits to you as it’s done for me.

Paul Lee.

This view from the South West 

shows the existing vs new elements.

Existing Dwelling

Refurbished

New Build

Garden Perspective (East)Visual connection between front and garden



Check out the Scene Tabs to see what each of them contains. When you’ve finished 
exploring, click on the “Plan” tab to begin the exercises. The units used in this book are 
millimetres-  Our SketchUp files have a millimetre default setting.

We’re going to 
finish this part.

This part is already drawn 
(inserted as a Component.)

Scene Tabs

Getting Started Page
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GETTING STARTED
First let’s check that we have the companion course models for this 
manual:

A. Construction Documents SketchUp Pro 2019_House Plan_X.X
B. Construction Documents SketchUp Pro 2019_Details_X.X

If you don’t have the above SketchUp files, you’ll need to download them 
from the Resources Section at www.SketchUp.Expert

To begin, open the SketchUp file “Construction Documents SketchUp 
Pro House Plan_X.X”. You’ll see the “Scene” as illustrated in (1). This 
provides instructions regarding the use of the file. Clicking on the “Plan” 
Scene as directed (2), you’ll notice that it consists of an outline drawing 
and an image. First we’re going to finish the highlighted part of the plan 
shown below. (The rest is pre-drawn.)

-> RESOURCES PAGE

1

2

http://www.sketchup.expert
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1 Draw a random line using the Line 
Tool.

2 Select the Tape Measure Tool, click 
on a random point on the line.

3 Move the mouse in the direction you 
want to place the (parallel) 
construction line.

4 Click to place the construction line at 
a random distance.

5 Type a number which represents the 
distance you want to give it and hit 
“enter”. The line is now at the 
distance from the line that you 
specified. 

6 Note that if you click on the endpoint 
of  a line, you will get a 
Construction Point, not a parallel 
line. Again, move your mouse in the 
desired direction and type a distance 
from the point and hit “enter”

7 Useful Tip: Typing “T” will activate the 
Tape Measure (Default Shortcut.)

End Point 
of  Line

Draw
ing

 Li
ne

Construction 
Point

DRAWING GUIDES (LINES & POINTS) AT A SET DISTANCE

Drawing Construction Lines Page
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DRAWING CONSTRUCTION LINES
The Tape Measure is a multifunctional tool. Besides providing 
measurements it also builds construction lines and points 
(“guides”). Guides are used to help create geometry.

We’re going to use the Tape Measure Tool to set up our first 
construction framework. We’ll then use that framework to “hang” 
our drawing. Below is a primer on how the Tape Measure creates 
construction guides.

Try this exercise yourself

2

3

4

6

7

1

The Line Tool



1. Using the Tape Measure Tool, click on the edge “A” as indicated.
2. Move the cursor to the right and click a random distance away.
3. Type the number “682” (Don’t click into any dialogue box to do this.)
4. Hit Enter.
5. The first construction line “B” is formed.

6. Click on the edge “C” as indicated.
7. Move the cursor upwards and click 

at a random distance.
8. Type the number “5898” 
9. Hit Enter.
10. The construction line “D” is formed.

Drawing The Plan Page
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DRAWING THE PLAN

A B

C

D

1 2

10

6
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DRAWING THE PLAN

Follow the procedure as outlined on the previous page to create the construction line “B” 
at a distance of “354” from “A”

B

A

INFERENCING

As we draw lines or use other tools to move or rotate things, we need to be able to refer to lines, points, 
angles or planes that are already in place. This is what’s known as inferencing. The diagrams below 
illustrate the various inferencing options.

END

MID EDGE - RANDOM EXTENDED

PARALLEL

INTERSECTION

INFERENCING ALONG A LINE- COLOUR INDICATORS

HOLD SHIFT KEY TO LOCK A DIRECTION.

ALSO USE THE ARROW KEYS- UP = VERTICAL AXIS, 
LEFT = GREEN, RIGHT = RED, DOWN = PARALLEL.

Drawing a line from one corner of an 
existing box to another corner is using 
inferencing to find the points of reference.

1
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DRAWING THE PLAN

Now we’ll draw lines to start forming the angled corner. To form the edge “C” takes a few 
steps. First we’ll form a construction point using a line.

1. Using the Tape Measure Tool click on the line “A” as indicated.
2. Using the procedure outlined previously, create a construction line “B” at a distance 

4482 to the left of “A”.

AB

C

The next tool we’re going to use is the 
Protractor which also produces a 
construction line. It requires picking:

A A turning point (or “Fulcrum”)
B Starting angle (0) 
C A direction
D An angle of rotation A. Turning point 

(“Fulcrum”)

B. Starting angle

C. Rotation Direction 

D. Type angle of  rotation

Sequence of  Clicks 
using the protractor

0 degrees

Note: If you 
accidentally 
change your 
viewpoint with 
the mouse, you 
can easily 
restore your 
position by 
clicking on the 
“Plan” Tab at 
any time.

2

1
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Intersection

DRAWING THE PLAN

1. Click on the intersection point “Z” (between the construction line and the horizontal 
line.)

2. Pick a zero starting angle “A”: Move the cursor to the right (We want to cursor to “stick” 
to the red axis.) Click.

3. Move the mouse upwards (Anticlockwise direction) and click a random angle. 
4. Type “81” and hit Enter.
5. The construction line at “B” is formed.

Z

B.
 R

ot
at

io
n

A. (Starting angle = 0)
(The “X” here 
indicates you are on a 
point of intersection.)

Using the protractor tool:

Always ensure to use inferencing carefully. You must see the “X” appear before clicking.

Type “81”

We’re now going to form a Construction Line using the Protractor Tool. The origin and the 
angle of rotation have to be established following the sequence below:

1 2

3

5
4
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DRAWING THE PLAN

1. Next: Using the Line Tool, draw a line starting from the point of intersection “X”.
2. Move the cursor onto the construction line. Notice the red dot appearing- This 

indicates that your next point will be placed on that line.
3. Hold down the shift button- Notice that with the Shift button held down, wherever 

you place the cursor it is stuck on the construction line.

4. While holding down the Shift 
Button, type “4648” and hit enter. 
(Note: In doing this, don’t click 
into the measurements dialogue- 
Just type the number.)

5. The line should appear as 
indicated.

X

The Line Tool

INTERSECTION

EDGE

1

2

5

3
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DRAWING THE PLAN
To draw a line from the endpoint of the previous line at a perpendicular direction:

1. Start drawing a line from the end of the previous line- Let’s call this “A”. (Make sure 
to start from exactly the end point. See the green dot occurring below.)

2. Without clicking on your mouse button, run the cursor along A.
3. Notice when you move the cursor around that a magenta line appears 

perpendicular to A.

END POINT

4 Move the cursor in the direction 
of the magenta line as illustrated. 
(Don’t drag or click the mouse 
while doing this.) 

5 With the line showing as 
magenta, type “5000” and hit 
Enter. (We’ll complete it later.)

6 The resulting line should be as 
indicated.

APERPENDICULAR

6

1

2

3

4
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Y

Z

DRAWING THE PLAN
Draw a line from the endpoint of the previous line at a perpendicular direction:

1. Start drawing a line from point X
2. Click on the intersection Y.
3. Start drawing a line from Point Y.
4. Float the cursor along line Z (without clicking) to pick up on it’s direction.
5. Notice when you wiggle the cursor around that a magenta line appears parallel to Z.

X

6. Whilst the magenta colour is 
showing,  type “1686” and hit 
Enter.

7. The line should be as 
indicated.

Note: If  you make a mistake, go 
back using CTRL + Z (UNDO)

PARALLEL

1

2

3

4

7
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Finish drawing the shape as outlined below using the construction points you created.

354

X

Line “A”

Line “B”

DRAWING THE PLAN
1. Using the Tape Measure Tool, click on a random point (not an end point) along Line 

A to create a parallel construction line at a distance of “354” from Line A.
2. Using the Line Tool, click on the point “X” to start a line from there.
3. Float the cursor along Line A to pick up it’s direction.
4. Move the cursor around so that it turns magenta (perpendicular direction to Line A.) 

Draw a line B perpendicular to Line A which meets the construction line as illustrated.

Using Endpoints
and intersection 
points, build the 
shape as indicated.

Use Shift to lock in 
the green direction 
and infer point “Z”

Z

1 2

4

X = 
Intersection 
points.

Finished shape

3

You should see 
a grey-blue 
colour appear 
within the area 
illustrated here.
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Offset lines 
inwards by 
77mm

Newly 
Offset 
Lines 

LINE “Z”A

B

C

D
Glazing

DRAWING THE PLAN

OFFSETTING LINES

Form inner lines to finish drawing the glazing 
around the perimeter.

1. Click on the Select Tool.
2. Holding down the Shift button, select 

lines C and D as indicated.
3. Click on the Offset tool.
4. Click on one or other of the selected 

lines.
5. Move the mouse inwards.
6. Click the mouse to select a random 

distance,
7. Type “77” and hit Enter.
8. The resulting lines should be as 

indicated.

SELECT TOOL OFFSET TOOL

The next tools we’re going to 
use are Select and Offset. 

Use the top 
tip of the 
arrow when 
selecting 
objects.

Finish the boundary shape.

1 Using the Tape Measure Tool 
double-click on Line “Z”

2 Using Select Tool, right-click on Line 
“Z” to delete it 

3 Redraw Line “Z” from Point A 
(Endpoint) to Point B (Intersection)

1 3

8

4
5

6

double 
- CLICK

2
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DRAWING THE PLAN

DRAWING THE STEPS

We’re setting up construction lines to create 

a drawing of the steps. We’ll first use the 

existing geometry of Line “A” to set up a 

parallel construction line at point “B”.

1. Click on the Tape Measure.

2. Click on Line “A”

3. Click to the left (anywhere) of Line A 

and type a distance of “91” to create 

construction line “B”

4. To create the next construction line, 

click on Line “A” again.

5. Click on Intersection point “C”. (This 

creates construction line “D”.)

6. Select the Line tool.
7. Click on point “C” and float the cursor 

on construction line “D” 

8. Type “1718” and hit Enter.

9. The resulting line should be as 

indicated.

AB

91
Steps

C

D
A

EDGE

9

5
4

1
23

6

7
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Z

B

A

6

5
4

3

2

1

DRAWING THE PLAN

DRAWING THE STEPS

1. Select the Line Tool.
2. Click on the endpoint “Z”.
3. Run the cursor along Line “A” 
4. Move the cursor to the right until 

you see the perpendicular 
magenta inference line appear.

5. Move the cursor onto the 
construction line “B” and click.

6. The line formed should be as 
indicated.



Drawing The Plan Page

CONSTRUCTION DOCUMENTS USING SKETCHUP PRO 2020

15Copyright Paul J. Lee 2020

A

DRAWING THE PLAN

DRAWING THE STEPS

1. Select the Tape Measure.
2. Click on the line “A”.
3. Click on any point above the line, 

type “255” and hit Enter.
4. Repeat to create a second 

construction line.
5. Start constructing the outlines of 

the steps using the methods 
previously outlined.

6. Draw the lines indicated in red. You 
should be able to complete the 
blue-grey region as indicated.

1

2

3 4

5

6

Faces are only 
formed when lines 
are properly joined 
end-to-end. 

If there are any 
minute gaps- even 
so small you can’t 
see them, then 
surfaces won’t form.

This line has no exact length.

Perpendicular Line
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A

B

Intersect Line

Draw the two 
line segments.

C

D

DRAWING THE PLAN

Finish the drawing.

To complete the grey-blue block as illustrated in 
below we first need to tidy up one section of the 
drawing. 

1 Zooming closely into Corner “A” we see 
that Line “B” doesn’t connect with the 
Intersect Line. 

2 To extend Line “B” as required, we first 
need to create a construction line. Use the 
Tape Measure Tool to double-click on 
Line “B”.  

3 Using the Move Tool, click on the endpoint 
of “B” and then click on the intersection 
point.

4 Finish by drawing in the two line segments 
illustrated here.

5 Delete Lines C and D (These represent 
the line of the glazing but for the purposes 
of building our slab they must be 
eliminated.)

Axis 
Direction

Line

Handy Tip:
Drawing or editing a line that is “nearly” parallel to an axis:

To overcome the axis snap function, zoom very close into the area 
that you need to place the endpoint of your line. Zooming increases 
relative distance between elements to make positioning easier. 

Zoom In

1

3

double 
- CLICK

4

2
5
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DRAWING THE PLAN
Now we’ll create a Local Component Collection for use in our model. This means we’ll make 
the SketchUp.Expert Collection available so that we can insert SketchUp components 
from it.

1 Click on the Components Dialogue on the right 
hand side of your screen.

2 Click on the right-hand arrow button
3 Select “Open or Create A New Collection”
4 Navigate to the SketchUp.Expert folder (which we 

downloaded from the website.)
5 Double-click on the folder.
6 Now the Collection is available for you to select 

Components from it. 
7 Click on the down arrow to see the full list of 

available collections.
8 Click into the SketchUp.Expert Collection to explore 

the components inside.

When you select the down arrow in the Components browser, you’ll see the 
“SketchUp.Expert Collection” folder listed. Click on the folder to see the contents.

1

A

B

C

D

E

2

3

4 double 
- CLICK

Down Arrow

7

8

5
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DRAWING THE PLAN

1 Select “SketchUp.Expert 
Collection” from the list.

2 Select the component called 
“_Plan_Insert” - This brings in the 
plan drawing.

3 Carefully select the zero point on 
the drawing plane as the location 
for the plan.

4 Right-click on the plan and 
select “explode”

5 Click on any one of the faces of 
the geometry. 

6 Notice how it’s broken into distinct 
regions defined by the boundary 
lines. These regions will form the 
basis for all your walls inside the 
model.

Regions

• External Walls
• Floor Slab
• Internal Walls

You can examine regions by 
observing the “blue dots” that 
appear when you click on a surface.

INSERTING THE DRAWING
Here we’ll select the plan drawing from the Component List and insert it into the model. Then 
we’ll explode this file to create regions such as: external walls - floor slab - internal walls.

1

2

3

4RIGHT - 
CLICK 

5

6
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SELECT TOOL

Closed Group: 

Notice that a selected closed 
Group is signified by the following:
 

• Blue surround box 
• Blue Object lines

When a group is closed it 
cannot be edited but it can be 
scaled and moved. To edit you 
have to open it. More on this later.

CREATING THE FLOOR SLAB GROUP

1 Using the Select Tool (while holding 
Shift) select all areas associated with 
the Floor Slab (including the steps)

2 See the selected area is highlighted 
with blue dots. 

3 When all the areas have been 
selected, right click on any part of 
this selection and select “Make 
Group”

4 Now the Floor Slab area has been 
grouped.

Using the 
Select Tool

Creation of Groups is fundamental to the structure of a SketchUp model. Here we start to 
create such a structure. The groups are organised in accordance with the regions 
outlined in the previous page. The first Group we’re going to make is the Floor Slab.

While holding 
down Shift, 
double-click 
each area as 
indicated here 
to add it to your 
selection

Notice the areas selected are dotted blue. 
(Don’t select the external or internal wall 
areas. If you make a mistake, you can de-
select by re-clicking on an element.

double 
- CLICK 1

3

Selected 
Closed 
Group

CREATING GROUPS & LAYERS
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A_Slab_GF

Right-Click on the Group and select “Entity Info”

GROUP NAMING & LAYERS 

1 Select the Layers Dialogue.
2 Click on the plus button.
3 A new dialogue opens to prompt 

you to name the new Layer. Call 
this layer “A_Slab_GF”

4 Next, expand the Entity Info 
dialogue by right-clicking on the 
group and selecting “Entity Info”

5 In Entity Info, name the Group 
Instance as “Slab_GF”

6 Place the Group onto the 
“A_Slab_GF” Layer using the pull-
down menu.

This gives you full control of the Group 
for efficient editing and model 
organisation. 

The importance of this will become clear 
later on.

Next we’re going to repeat the process 
to create, name  and organise the 
External and Internal Walls Groups.

The next step is to name the Floor Slab Group and put it on its own named Layer. 
This allows you to identify and locate the Group as you build your model.

Update the Entity name (“Instance”) and select a 
layer for it (A_Slab_GF) from the pulldown menu.

A_Slab_GF

RIGHT - 
CLICK 

1

2

3

4

5

6

CREATING GROUPS & LAYERS
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Select the area 
of the External 
Walls and 
“Make Group”

Select the 
area of the 
Internal 
Walls and 
“Make 
Group”

_GF
_GF_GF

_GF

External Walls

1 Create a layer called “A_Walls_Ext”
2 Select the external walls region as 

indicated. (Double-Click while holding 
Shift to select multiple areas.)

3 Right-click on the area and select 
“Make Group”. 

4 As in the previous example, with Entity 
Info give the Group a name. In this 
case it’s “Walls_Ext”. 

5 With the Group selected, put it on the 
“A_Walls_Ext” layer.

Internal Walls

6 Using the Select Tool (while holding 
Shift) select all areas associated with 
the Internal Walls.

7 Right-click and Make Group.
8 Create a Layer “A_Walls_Int” and 

name the Group as “Walls_Int_GF”

Now we’re going to name the External Walls Group and Ground Floor 
Internal Walls Group and put these Groups on their own named Layers.

A_Slab_GF

A_Walls_Ext

double 
- CLICK

RIGHT - 
CLICK 

12

3

4

RIGHT - 
CLICK 

5

6 7

8
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Select the Scenes Tab

Right-click on the 
object and select 
“Edit Group”

SECTION 
DRAWING

Use the top 
tip of the 
arrow when 
selecting 
objects.

1 Next we get to the 3D modelling part. We first of all start by selecting the 
“Modelling Perspective” Scene Tab at the top of the screen. 

This scene has been set up to show a number of drawings all placed in the exact 
locations to correspond with the model we’re going to build. These “prepared earlier” 
drawings allow us to concentrate on modelling only.

ELEVATING THE EXTERNAL WALLS

In the next part we’re going to use the Push-Pull Tool to stretch the walls up to the height 
of the walls in the Section Drawing. First we need to open the Group for editing:

2 Using the select tool, right click on any part of the External Walls Group and select 
Edit Group. 

RIGHT - 
CLICK 2

Modelling Perspective1

MODELLING THE HOUSE
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PUSH-PULL 
TOOL + 
INFERENCING 

An Open Group is 
indicated by dotted 
lines with 
surrounding objects 
being faded out.

PUSH-PULL TOOL

Section Drawing

ELEVATING THE EXTERNAL WALLS

1 Using the Push-Pull Tool, float over the wall region. (There are 3 distinct regions to 
elevate.)

2 Click on the surface to start elevating.
3 When you start to elevate the walls, move the cursor to the corresponding location 

on the section drawing.
4 Click on the corresponding location. 
5 Your walls should match the image below.

Using the Push-Pull Tool to achieve height parity: Above are two (non-grouped) solids of 
differing heights. We want to make the smaller one as tall as it’s neighbour. To do this, use 
the Push-Pull Tool. Float on the top surface of the solid as indicated and click on it (A). 
Move the cursor onto the top of the adjacent solid and click on it. (B). The two solids are 
now the same height.

1

A

B

2
3

4

5
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MOVE TOOLSELECT TOOL

Group Bounding Box

CLOSE THE WALLS_EXT GROUP 

Right-Click into an area outside of the bounding 

box and select “Close Group”

REPOSITION THE FLOOR SLAB 
We’re going to move the Floor Slab upwards to the level indicated on the Section Drawing: 

1 Using the Select Tool, with a single click select the Floor Slab and the Internal Walls Groups.

2 Select the Move Tool and click once on the Slab to start moving it upwards

3 While moving the slab, hit the Up Arrow on your keyboard to lock in the Blue Direction. 

4 Click on the Adjacent Line representing the top level of the Floor Slab.

5 When you’re done, don’t forget to close the Group. (Right-click on blank space and select “Close 

Group”)

2

3

4

1
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Hide = OFF
Surrounding Geometry is 
greyed out but still visible.

1. Red and Grey Groups are closed. 2. Open the Red Group. 

Hide = ON
Surrounding Geometry is 
invisible.

Red Group

Grey Group

TOGGLING ON/ OFF “HIDE REST OF MODEL” 

3. Switch off visibility of 
surrounding geometry

SketchUp has the ability to instantly turn on and off visibility for geometry outside of an Open 
Group. This is hugely advantageous and greatly increases modelling speed. 

1. Select Window > Preferences > 
Shortcuts. (SketchUp > 
Preferences > Shortcuts for Mac)

2. Type “hide” into the filter search.
3. Click on the selection called: 

View> Component Edit> Hide 
Rest of  Model.

5. Type “H” into the “Add Shortcut” 
Dialogue and click on the “+” 
button.

6. You will be asked if it’s OK to 
override an existing function. 
Select “Yes”.

Now the shortcut is ready. Test the effectiveness 
of the shortcut by opening any group in your 
model. Hit the “H” key and see how the 
surrounding geometry disappears. To make it 
reappear just hit “H” again. We’re going to use 
this shortcut in our modelling from here on.

Let’s create a shortcut for this function.

RIGHT - CLICK > 
OPEN GROUP

“POWERFUL SHORTCUT No. 1”: HIDE
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Lower Floor Level

Push Pull this floor 
surface downwards to 
match the drawing profile.

EDITING THE SLAB
1 Right-Click on the Slab Group and 

select “Edit Group”
2 Activate the “H” Shortcut to Hide 

Rest of Model
3 “Repair” the slab (fill in the empty 

parts) by redrawing the edges as 
illustrated.

4 Delete the lines.
5 Using the Push-Pull Tool Click on 

the isolated area of floor as 
indicated here.

6 (Can’t see the section drawing? 
Press “H” again.)

7 With the section drawing visible, 
move the cursor over to the lower 
floor level.

1

2

5

7

3

4

6
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Delete top and 
side edges

Vertical 
line

EDITING THE SLAB
Here we clean up the slab group and create the three steps.
(Reminder: Make sure the Slab Group is open. Otherwise you can’t edit it.)

1 With the Slab Group open, using the 
Eraser Tool delete the edges of the 
surfaces indicated here.

2 Now right-click on the vertical line 
and select “Divide” 

3 You’ll notice that red squares 
appear on the line. They increase 
and decrease as you slide the 
cursor up and down. When you 
arrive at 3 divisions, click to accept.

ERASER TOOL SELECT TOOL

RIGHT - 
CLICK 

1

3

2

MODELLING THE HOUSE
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PUSH-PULL TOOL

Click on the 
“Lower Step”

“Upper Step”

First third

EDITING THE SLAB- Finishing off the Steps

1 Using the Push-Pull Tool, click 
on the surface of the “Lower 
Step”.

2 Move the cursor until it meets 
the top of the lowest line 
division “Endpoint”. Click to 
accept.

3 Click on the surface of the 
“Upper Step” and repeat the 
process.

4 With the steps completed, 
close the Group.

1

2

3
4
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Knowing how a model is structured means that we can work efficiently. To do this, 
we have a dialog called “Outliner” which lists all the groups, components and “Section 
Cuts”* inside it. Outliner describes the entire model in a “Tree/ Branch” structure. It also 
tells us what group we’re currently editing. Any Group or Component can contain “Sub-
Groups” or “Sub-Components”.

“OUTLINER” EXAMINES THE STRUCTURE OF YOUR MODEL AND ALLOWS YOU 
TO CONTROL IT.

• To select a Group or Component, simply click on it. 
• To edit the component itself, double-click on it, or right click to select “edit”
• You can also drag and drop any Group or Component into any other Group or Component. 

GROUP

COMPONENT

To expand the Outliner dialog click on the black arrow where you’ll find all the 
Group, Component and Section* contents in your model. 
If  a particular layer is switched off, you won’t see related contents.

Main Model File

Group (Unnamed) Square icon = Group.

Sub Component Four Squares = Component.

The “+” sign indicates that a Group or Component is “minimised” so that you can’t 
see it’s contents. To expand it, simply click on the box. You’ll see that “+” changes 
to “-“ and the contents are expanded to be made visible.

SECTION CUT

SKETCHUP 
FILE (HOME)

(CLOSES ALL GROUPS/ COMPONENTS)

To make Outliner visible: 
On the list of menus to the right of 
your screen in what’s called the 
“Default Tray” then you’ll need to 
add it. This is done by selecting 
Window/ Manage Tray/ Default 
Tray and then selecting the 
“Outliner” tick box in the Dialogs 
list.

Drag - and - drop

click

STRUCTURING YOUR MODEL
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Your building model grouping is best structured as 
indicated in this 3 Storey Building descriptor.

BUILDING

EXTERNAL WINDOWS

LANDSCAPE SECTION CUTS

SKETCHUP FILE (HOME)

LANDSCAPE/ EXTERNAL MODELS

FLOOR 0 (SLAB)

FLOOR 1 (SLAB)

FLOOR 2 (SLAB)

EXTERNAL WALLS

EXTERNAL DOORS

CHIMNEY

INTERNAL WALLS FLOOR 0

INTERNAL WALLS FLOOR 1

INTERNAL WALLS FLOOR 2

INTERNAL DOORS FLOOR 0

INTERNAL DOORS FLOOR 1

INTERNAL DOORS FLOOR 2

BUILDING SECTION CUTS

Each colour here 
represents a location 
within which elements 
are contained

STAIRS

=
 G

R
O

U
P

=
 C

O
M

P
O

N
E

N
T
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Always remember to close 
groups when done editing.

Use the “H” shortcut 
to turn back on the 
view of the rest of the 
model if not visible.

EDITING THE INTERNAL WALLS
Now that we’ve done work on the External Walls and Slab Groups we’re going to tackle 
the inside walls. 

1 To open the internal Walls Group, 
expand Outliner and select 
“Walls_Int_GF” from the list. (Double-
click to open)

2 Select the Push-Pull Tool and click on 
any one of the wall surfaces. 

3 Move the cursor level with the top of 
the external walls. 

4 Repeat this process with all the 
internal walls until they are complete.

5 Close all Groups- You can either click 
on the Home icon in Outliner or Right 
Click on the background and select 
Close.

2

3

4
RIGHT - 
CLICK / 
close group

5

5

1

double - CLICK 
(this is a shortcut 
for repeating last 
push-pull input)

MODELLING THE HOUSE
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Lower Level

EDITING THE SLAB- Adding thickness. Open the Slab_GF Group

1 Select the Push Pull Tool.
2 Click on the lower slab surface as 

illustrated and move the mouse 
downwards.

3 If the surface doesn’t produce a thickness, 
hit the CTRL key (or the alt key for Mac 
users) to add a new surface. The “+” sign 
appears next to the Push Pull Icon.

4 Move the cursor over to the section 
drawing to infer the corresponding depth 
of the slab.

5 Repeat this process for the higher floor 
level.

You may have to fix some geometry that contains 
holes. This is done by simply redrawing lines that 
“support” the geometry. Normally this fixes the 
surfaces.

Sometimes geometry may not behave in a 
predictable way- Geometry may not form or it may 
not allow you to edit it. The next page contains 
some pointers on dealing with this.

Surfaces can be formed “inside out” (blue-
grey)

6 To reverse any surface, right-click on it 
and select “Reverse Faces”. You can 
select multiple surfaces at a time- 
(CRTL + A selects all surfaces at once) 
or alt + A for Mac.

7 To orient all surfaces to match, right-
click on a face and select “Orient 
Faces”.

ORIENTING THE FACES

RIGHT - 
CLICK 

1

2

3

4

5

6

7
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When we have a missing face such as this, the normal way to fix it is to 
re-draw an edge.
When this doesn’t work, there is some problem with the geometry.
The list of potential geometry problems are:

▪ Broken edges (multiple end points)
▪ Hidden/ Buried lines
▪ Off-axis lines
▪ Non-coplanar faces

It’s difficult to figure out which problem you’re encountering.

FIXING GEOMETRY

Moving this edge shows 
there are no broken lines

Redrawing any edge 
will normally “heal” the 
object.

MISSING SURFACE 
ON A BOX

Moving a corner point shows if 
there are any breaks or un-
connected edges. No problem 
presents itself here

In this instance, moving the corner 
point doesn’t drag the edge along 
with it.

Move the corner point. All the edges respond as 
expected. 

Move the edge (pick a random point- Not 
an endpoint.)

Move the corner point. One 
edge doesn’t respond. 

Here we can see 
there’s a broken 
edge. (2 edges 
joined.)

Zoom in to inspect the corner.

Edge 1

Edge 2

To fix the surface, delete the faulty edges and redraw.

In this instance a 
hidden line shows up.

Edge 1

Edge 2

Hidden 
Edge 3

Non-responsive line
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1

2

3
4

A

B

MAKING THE ROOF

To make the hip roof, we’re going to create a profile of 
“half” the roof and then extrude this profile around in a 
“horseshoe” shape to complete the hip roof shape.

SET UP CONSTRUCTION LINES

1 Orbit into a good position like that 
illustrated 

2 Select the Tape Measure Tool. 
3 Click on a random point along the long 

edge of the wall (A)
4 Click on a node point on the section 

drawing as indicated (B)
5 Repeat this process to create four parallel 

construction lines as indicated.

TAPE MEASURE TOOL

DRAW THE ROOF PROFILE

6 Using the Line Tool, let the cursor rest on 
a Construction line.

7 Holding down the Shift Key, move the 
cursor to the back edge of the external 
wall.

8 Click the mouse in this location to begin 
drawing the profile shape.

9 Repeat the process on each construction 
line to complete.

Go to the next page >>>

LINE TOOL

Extruding the 
Profile makes the 
hip roof shape.

SHIFT KEY

Shape we’re going to set up.

Profile

Path

2

3

5

6

7
While holding the Shift Key, 
move the cursor in line with 
the back edge of the wall.

Complete the profile

1

4

8

9
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Profile to be 
extruded

THE FOLLOW-ME TOOL

C. Click on 
a surface to 
be 
extruded.

B. Click on 
the Follow-
Me Tool

A. Select an 
extrusion 
path.

D. Finished 
Object

Extrusion 
Path

CREATE THE MAIN ROOF USING THE FOLLOW ME TOOL

DRAWING THE EXTRUSION PATH

1 Draw a rectangle around the outer edges 
of the main part of the house. (Make sure 
lines are precisely located on each corner.)

2 Using the Select Tool select the extrusion 
path- Hold down the Shift Key, select the 
three lines  as indicated.

3 Select the Follow Me Tool. 
4 Click on the profile.
5 The roof  shape should appear instantly.
6 Triple-click on the roof geometry to select 

the entire roof.
7 If the roof appears blue-grey, right click 

and select “Reverse Faces”- If the surfaces 
are white then leave as-is.

8 Right-Click and select “Make Group”
9 In Outliner right-Click on the new Group 
10 Select “Rename” on the Menu
11 Type “Roof  01” as the name for the Group.

triple-
click 

2

3

4

5

1

RIGHT - 
CLICK 

86
RIGHT - 
CLICK 

7
Group

Rename

RIGHT - 
CLICK 

9

10
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Select random point 
along external wall

The 
Section 
Drawing

Node 
Points

1.

2.

3.

4.

Create four 
parallel 

construction 
lines

A_Roof

THE CONSTRUCTION FRAME

1 Using the Tape Measure 
Tool, click on a random point 
along the external wall. 

2 Place construction lines by 
clicking on node points.

3 Repeat the process until the 
four construction lines are in 
place.

CREATE THE SIDE EXTENSION 
ROOF

First we’ll create the roof profile to 
be extruded using construction 
lines coordinated with the Section 
Drawing. 
Then we’ll extrude this shape to 
create the roof.

Create a layer called “A_Roof” on 
which we’ll place the main roof and 
side roof Groups. 

1

2

3
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Use the Left 
Arrow key to lock 
in the direction of 
movement along 
the Green Axis.

Infer the inside of the wall to position the profile.

Drawing the profile 
using the Construction 
Lines.

CREATE THE SIDE EXTENSION ROOF

USING THE LINE TOOL TO CREATE 
THE PROFILE

1 The first point that you choose on 
the Construction Line is random- 
The next three must coordinate 
with the first. 

2 To place the next point of the line 
rest the cursor on a Construction 
Line 

3 While holding Shift, click on the 
previous endpoint. Repeat this 
process to complete the profile 
shape. If properly formed, the 
shape will have an internal surface.

4 Move the profile into place against 
the inside of the Side Extension. 
Use the Move Tool to select and 
move the profile (shape) along the 
Green Axis. Use the Left Arrow 
Key on your keyboard to lock in 
the direction.

Here we’ll draw the Profile in an isolated location and extrude it to create the roof.

1

2

3

4
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Start extruding 
the Profile.(Not 
yet grouped.)

Infer the 
adjacent wall.

Edit the 
“Walls_Ext” 
Group: Raise the 
parapet to match 
the Section 
Drawing.

Create a Group for the flat 
roof called “Roof_02”

A_Roof

Roof_02
Top of 
Parapet.

1 Use the Push Pull Tool to extrude 
the profile along the length of the 
extension as illustrated.

2 To create a Group for the Roof, 
using the select tool triple click on 
the roof surface to select it, right-
click on the selection and select 
“Make Group” 

3 Right-click and Select “Entity Info” 
Name this Group “Roof_02”

4 Place the Group on “A_Roof” layer 
5 To edit the parapet, Right-Click on 

the Walls_Ext Group and select 
“Edit Group”. 

6 Use the Push Pull Tool to raise 
the height of the wall to coincide 
with the profile drawing as 
illustrated.

FINISH THE SIDE EXTENSION ROOF AND PARAPET WALLS

Triple clicking on a 
surface selects all 
adjoining surfaces.

TRIPLE CLICK

right CLICK

1

2

3

5 6

MODELLING THE HOUSE



Modelling the House Page

CONSTRUCTION DOCUMENTS USING SKETCHUP PRO 2020

39Copyright Paul J. Lee 2020

FINISHING THE PARAPET WALLS
Use the Tape Measure, Line and Push Pull Tools to shape the top of the Parapet.

Using the Tape Measure Tool, click a random point on Edge “A” 
and place it on the corner point “B”

Draw a Line over the Construction Line and Push Pull to other face.

Delete stray lines using Eraser Tool. 

This is what the result should look like so far.

Push Pull the small triangle that was left over. Note that as you 
push pull across, the geometry gets “stuck”. This is due to the 
lines that exist inside the wall (See illustration) To overcome this, 
keep push-pulling incrementally until you reach the end.

Using Tape Measure, double-click on Line C. 
Delete Line D.

C

D

Lines inside the wall.

1

2

3

4

5

6

A

B
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FINISHING THE PARAPET WALLS

Use the Tape Measure, Line and Push Pull Tools to shape the top of the Parapet.

This is what the end result should look like.

Draw a line along the construction line and Push Pull 
to face.

Push Pull the 
blue marked 
surface to 
opposite face

Orbit around to the other side of the wall 

Use 
inferencing, 
draw a line as 
an extension of 
the existing.

Run cursor along this line to pick up direction

Push-pull shape to the end of the wall. Delete 
unnecessary  lines (if any)

1

2

3

4

5
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FINISHING THE PARAPET WALLS

Use the Tape Measure, Line and Push Pull Tools to 
shape the top of the Parapet.

Push-Pull the remaining piece of wall to complete the parapet.

This is what the end result should look like.

Open the “Walls_Ext” group using Outliner or Right-Click-Edit Group.

Use the Tape Measure to create a construction line.

Draw a line along the blue axis to start making the “cut-out” shape.

Draw a line along the red axis to finish shape

Using Tape Measure select a 
random point on the end line 
and create a construction line 
(say 200mm away from edge)

Parapet detail at front side of the house

Use the “H” shortcut to 
temporarily remove the 
roof from view.

A. Draw a line from the 
intersection of the 
construction line and the 
edge of the parapet.

B. Lock into the blue (vertical axis using 
the up arrow on your keyboard.) and click 
on the roof surface.

UP ARROW

To finish the detail, push-pull 
the horizontal surface to align 
with the underside of the 
soffit. (Orbit around to view.)

Soffit 
line

1

2

3

4

5

6

MODELLING THE HOUSE



Modelling the House Page

CONSTRUCTION DOCUMENTS USING SKETCHUP PRO 2020

42Copyright Paul J. Lee 2020

PLACING OPENINGS IN THE WALLS

Use the Rectangle tool to draw openings that correspond to the elevation drawings.

Edit the Wall_Ext Group. Use Outliner or double-click using Select.

Finish drawing all the opes using the above method.

The easiest way to test if 
a group is open is to click 
on a face. If you see the 
blue dots then you know 
the “raw geometry” is 
editable.

RECTANGLE 
TOOL

Open the Walls_Ext Group.

To draw a rectangle onto the wall:

1 Ensure the correct Group is open. 
(Test by clicking on a face to see if 
blue dots show up.)

2 Select the Rectangle Tool.
3 Float the cursor onto the surface in 

which you wish to create the 
opening.

4 Hold down the Shift button to lock 
the cursor onto the surface. Note 
the magenta colour appears which 
indicates the “locking” effect.

5 Float the cursor onto a reference 
point. 

6 Click on the reference point.
7 Click on the opposite point
8 The rectangle is now formed.
9 Finish all the opes using the same 

method.

Reference Points

Reference Points

Open the Walls_Ext Group using Outliner

Note: We’ll 
look at the 
arch later. 
Just treat the 
ope as a 
rectangle for 
now.

1
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FORMING OPENINGS IN THE WALLS

1.

2.

Start to push the opening area back

When the front surface meets the back surface they cancel out.

3.

Opening formed.

Finish creating all the openings:

1. Ensure the correct Group is open.
2. Select the Push Pull Tool.
3. Click on the surface inside the rectangle 
and push this surface to the adjacent one.
4. Finish all the opes to the front and the 
rear in a similar way, using the drawings 
as a guide.

If you aren’t operating inside the group 
which contains the geometry you wish to 
work on, none of the drawing and editing 
tools will work- (as in: splitting faces, push-
pull, offset etc.) 

PUSH-PULL TOOL

Note the following 
indicators showing that 
the front is aligned with 
the back surface:

1. Dashed line
2. Blue Diamond 
3. “On Face” note.

When you see these 
indicators you know that  
the opening will form 
correctly.

Having formed your 
shape, Click on the 
surface bounded by the 
rectangle.

Note: We’ll look at the arch 
later. Just treat the ope as 
a rectangle for now.

MODELLING THE HOUSE
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edge

View/ Rendering/ Edge By Axis

Shortcuts

1. Select Window/ Preferences/ 
Shortcuts. (SketchUp > 
Preferences > Shortcuts for Mac)

2. Type “edge” into the filter search.
3. Click on the selection called: 

View/ Rendering/ Edge/ By 
Axis

4. Type “/” into the “Add Shortcut” 
Dialogue and click on the “+” 
button.

5. If you’re asked if it’s OK to 
override an existing function. 
Select “Yes”.

Now the shortcut is ready. Test the 
effectiveness of the shortcut by hitting the the “/” 
key and see how the axis-aligned lines change 
colours.

Lines parallel to red axis turn red, green axis 
green, blue etc. 

Lines that are not aligned to an axis will show 
black.

To make the lines return to their 
normal appearance, just hit “/” 
again. 

SketchUp allows you to examine which lines are conforming to the current axes. Model 
faces need to be precisely parallel for faces and lines to interact correctly. Examining 
lines using the following method is a convenient and quick way of ensuring that lines and 
surfaces are parallel with each other.

Set up the shortcut through Preferences (On a Mac: SketchUp/ 
Preferences)

Pressing the “/“ shortcut shows up all lines that are parallel to an axis. 
Pressing it again turns the lines back to normal.

Non axes aligned lines show black

Use this shortcut to check your model especially 
where you’re finding geometry tricky to deal with.

CREATE “POWERFUL SHORTCUT No. 2”

1
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PLACING OPENINGS IN THE WALLS

Using the 2 point Arc Tool, draw the arc as illustrated below, and complete the window ope.

Point “A”

Point “B”

Point “C” (Using Up Arrow Button)

1. Use the 2 Point Arc Tool which is found by dragging the Arc flyout menu. 
Click on the two Points A and B. Use the Up Arrow key to lock in the vertical direction.to form the middle point 
by clicking on Point C

2. Push-pull the arch back to the inside surface to finish the ope.

Push-pull arch shape back to 
inner wall surface

Completed arch.

1

2
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CREATING THE WINDOW COMPONENT

Draw a series of rectangles onto the elevation drawing to describe 
the parts of the window. Redraw all the rectangles to create 
different regions.

Push - pull the window frame outwards by 85mm to start creating 
the body of the window

Using the Select Tool double-click the inner frame surface to select the 
sash element. Hold down Shift and double-click on the inner surface.

Right Click on the selected parts and choose “Make Component”

Name the element as “Window_Leaf” Make sure “Replace 
selection with component” is selected, and click “Create”.

1

2

3

4

5
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CREATING THE WINDOW COMPONENT

1.

2.

Select the closed Window Leaf Component and, selecting the 
bottom left corner of  the leaf  frame move towards the front edge 
of the window frame.

Window Leaf moved into place.

3.
Right-click> Edit Component to edit Window Leaf .

4.
Push-pull the frame part outwards by 65mm.

Move the glass pane from it’s position to the midpoint of the frame

Double-click the glass panel surface and select “Make Group” 
Call the Group “Glass Pane”.

5.

6.

When moving with precision, 
pick a point on that object that 
maps onto it’s target position.
 
(For example corner of object 
maps onto corner of target 
object.)

MODELLING THE HOUSE
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CREATE THE WINDOW COMPONENT: TEXTURING & GROUPING

The Paint Bucket Tool opens up the Materials Browser. Select 
“Glass and Mirrors” from the drop-down menu. Colour the glass 
pane using grey translucent glass. Close the component when 
finished.

Submerge the small frame back into the main frame: Pick the 
midpoint of the Window Leaf frame, and position this point at the 
corresponding corner of the Main frame (2.)

Edit the main glass panel as before and position it in the centre of 
the Main Frame. Do the same with the top panel. Copy the 

Triple-click on the main window frame to select it. 
Right-click and select “Make Group”- We won’t name it.

Right-click on the selection. 
Click on “Make Component”. Name it “W_01”.

Select all the elements using a left to right drag window selection.

1.
2.

Ensure “Replace selection 
with component” is ticked.

Materials Browser

PAINT 
BUCKET 

TOOL

Drop-down menu

Main frame.

Main glass panel.

Top glass panel.

RIGHT - CLICK 

triple 
- CLICK RIGHT - 

CLICK 

Left-to-
right-drag 
select

1

2

3

4

5
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A

B

C

MOVING THE WINDOW COMPONENT INTO PLACE AND FINISHING THE OPE STEP.

To correctly place the window component:

1. Select the object 
2. Select the Move Tool.
3. Before moving the object, choose a definite point 
on it that you know you can position easily. 
(Usually a corner point on the front-bottom.)
4. Move the object to the predicted target point. 
(Here it’s the centre of the wall thickness.)
5. Note the dialogue that displays the location.

- Open the “Walls_Ext” Group. 
- Draw a line to define the step down.
- Push-pull while floating the cursor to the 
bottom of the door leaf to infer correct level.

1. Pick a good “control point” from which to start moving the object.

2. Know where you’re going to place that “control point”.

FINISHING OFF THE STEP-DOWN 
IN THE DOORSET WALL OPENING.

D

Use Outliner to examine the structure of your model as it 
progresses. Try to become familiar with how it works, and 
how it can help you figure out where you might be going 
wrong if you’re getting stuck.

Drag-and-drop 
“W_01” Component 
into the “Walls_Ext” 
Group

W_01

1

2

3

4

5
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INSERTING THE WINDOW AND DOOR COMPONENTS

In this section we’re going to populate the model with windows, doors and rear flat roof.

A
Find the Component in the Dialogue.

Select the prepared components:

A set of the windows, doors and flat roof have 
been prepared and ready to insert. 

1 Select Modelling Perspective 
Scene.

2 Expand the Components Dialogue
3 Click on the Home button. This 

displays all the embedded 
components in the file.

4 Select “_Windows, External Doors & Flat 
Roof”. This component has an “insertion 
point” that corresponds with the corner 
point of the extended floor as indicated 
here.

5 To place, click here.

Place the Component at the corner of the slab.

2

3

4B

Modelling Perspective

1
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FINISHING OFF THE SLAB

Find the Slab Component in the Dialogue.

Use the “H” Shortcut to hide and unhide the surrounding geometry.

Finish off any gaps using the line tool and push pull the relevant 
surfaces to align edges.

Open the “Slab_GF” component by using Outliner or by double-clicking on it. Tidy up 
the surfaces and align the edges (if necessary). 

Orbit to the underside of the slab. Finish off missing edges. Delete 
untidy edges. Finish off surfaces to complete the slab.

1

2

3
4
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Open Walls_Int_GF Group for editing

Select all of the contents inside the Group. (CTRL + A)

Right-click on selected areas then “Intersect Faces> With Model.”

Orbit into a good position to view the areas for 
selection. (Line up your viewpoint along this wall)

Right-click on the selected area then choose “Make Group”

Delete the intersecting volumes. (There are some leftover parts that 

we’ll deal with later.)

To zoom in on a particular area the “Zoom Selection” 

command is extremely useful.

Here you’ll notice those 

areas that interesect 

with the roof have now 

been marked out. 

Left-to-Right (drag) selection to select the areas for deletion.

Be careful not to include any areas that you don’t want to select.

The relevant Group must remain open during editing.

The relevant Group must 

remain open during editing.

Right-click erase the Group.

Note: If  you delete without grouping, then you can 
unintentionally delete some surfaces you want to keep.

COMPLETING THE INTERNAL WALLS

Next we’re going to remove those sections of the internal walls that intersect with the 

roof. To begin, open the “Walls_Int_GF” group using Outliner.

1

2

3

4

5

6

drag 
l > r

RIGHT - 
CLICK 

RIGHT - 
CLICK 
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Draw shapes to fill in the volumes. Delete the discarded lines. Alternatively use the rectangle tool to draw the extrusion shape. 

The blue dots 
indicate an active 
surface to be 
manipulated. 
Remember- if you 
don’t see these dots 
appearing it may be 
because you haven’t 
opened the correct 
group!

Drawing a line which “splits” a surface to be extruded.
To draw a line at a corresponding level, float the cursor onto a vertical line (1). When the cursor is in place, hold down 
the Shift button to lock it onto the line (2). As you do this, move the cursor onto the adjacent level and click on it (3).

21
00

m
m

 h
ei

gh
t

Complete the shape to be extruded 

Use the same methodology 
as previously outlined to infer 
corresponding level (height).

2. Infer this edge1. Start push-pull of the 
shape from this side.

COMPLETING THE INTERNAL WALLS - FILLING IN THE DOOR HEADS

There are two approaches to creating this geometry-  Use construction lines to create a framework-  
or use inferencing.

Redraw the edges of the top of the walls (if desired but not necessary.) 
Use the tape measure to create construction lines @ 2100mm height.

Always orbit and zoom into a good 
position to make modelling easy.

A. Float the cursor onto the vertical line.

B. Hold down the Shift key

C. Move cursor to any reference point at 
corresponding level and click to select.

Construction line

New surface (red 
area) will be 
created by the line

Corresponding 
level.

1

2

3

4

5

6

double 
- CLICK
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We can search for a particular group, component or other 
element within the filter. Here we’re searching for “walls”. We can 
see that all elements containing the word “Walls” show up in the 
list.

Pro tip: You can open an element by clicking on it and pressing 
the Enter Key on your keyboard. (This has the same effect as 
double-clicking on it or right-click “Edit component”)

Home Button

When moving an object always use a near-side corner point on the object. The destination point should be visible without 
needing to orbit around the model.

Destination 
Point 

(Both start and end points are visible from this vantage.)

Destination 
Point 

COMPLETING THE INTERNAL WALLS - INSERT THE DOORS

To create the internal doors we’re going to fetch and insert a component called “Doors_Internal_” 
which is located within the SketchUp file.

Using Outliner lets make sure that we’re still editing the Walls_Int_GF Group:

1 Open up the Components browser. 
2 Click on the home button to view the components that are 

embedded within the SketchUp file. 
3 Use the pull-down menu to view Components as icons or 

as a list. (Try both views to see the difference.)
4 Find “Doors_Internal_” Click on it and then move your 

cursor into the model space.
5 Place the Component randomly by clicking on any point 

on the ground plane. (Don’t open or edit the Component.)
6 Pick a strategic point on one of  the doors to start 

moving the component.
7 Move the component into place.

Start 
Point

1

2

3

4

6
7
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RIGHT - CLICK 

The Section Toolbar

select

Here we’re going to learn about setting up and using the Section Tools.

Same object in section but 
open sided: No infill.

Closed object 
in section.

1 2 3 4

PLANS SECTIONS & ELEVATIONS: THE SECTION TOOLS

CALLING UP THE SECTION TOOLBAR

1. Right-click on the grey area at 
the top of your SketchUp Window. 
This brings up a Menu. 

2. From the Menu select “Section”

WHAT DO THE FOUR SECTION TOOL 
BUTTONS DO?:

1. Creates a Section Cut.

2. Makes all Section Frames visible/ 
invisible.

3. Slices/ Unslices the model.

4. Activates/ Deactivates “Infill”.
(This is a new important feature introduced in 
SketchUp 2018.) 

Note: Only an object that is “closed” will allow 
infill to autogenerate.

On a Mac, right-click on the 
top bar (grey area) and 
select “Customise Toolbar”

1

2
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1. The first thing we do is position our “Section Cut” 
These are located and oriented where we want to 
“slice” our model.

2 Section Cut is activated.

Here’s where we start to create our “drawings”. To do this we set up “Scenes” (views of the 
model) in SketchUp, and then we’ll import them into LayOut. This is an overview only- 
Detailed steps to follow in the next few pages.

4. The Scene is displayed in LayOut- SketchUp’s 
2D graphic program. 
(See the LayOut section of this book for details.)

What is a “Scene”?

“Scenes” are like camera viewpoints from which we view our 
SketchUp model. They can be set up as Plans, Sections, Elevations, 
Isometrics, or Perspectives and represented in different Styles.

3 View is aligned and Scene Created.

(OVERVIEW) CREATING PLANS SECTIONS & ELEVATIONS

Our “Scene” represented in LayOut 

When a Scene is 
created it is listed here.

Section Cuts

The model is 
“sliced” when 
the Section 
Cut is 
activated.

Our viewpoint is 
aligned with the 
Section Cut.

Blue colour 
indicates 
selected 
section cut.

SketchUp Scenes 
represented in LayOut

LayOut Title Block

1

2

3

4
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Click on the first button to bring up 
the Section Cut mechanism.

Here we’re going to learn about setting up and using the Section Tools.

The Section Cut mechanism aligns 
itself with whichever surface your 
cursor is hovering over. When it is 
in the desired orientation, hold 
Shift to lock it in.

For example, a plan is achieved 
by locking into the blue colour. 
(perpendicular to vertical.)

Holding Shift locks in the 
Section Cut orientation.

Red, green, blue and magenta (off-axis) orientations.

You can move 
selected cuts like 
any object

Plan 
Orientation

Rectangular 
Solid

PLANS SECTIONS & ELEVATIONS: THE SECTION TOOL

When the Section 
mechanism is oriented 
to an off-axis plane, it 
shows up as 
magenta.

CREATING SECTION CUTS

TRY THIS ON A BLANK SKETCHUP FILE- (File > New)

-  Create a rectangular solid.
-  In the Section Toolbar Select the Section Cut tool (The first 

button.)
-  Float the cursor around the object and observe how it reacts to the 

different surface orientations: How it changes colour to Red, Green 
and Blue.

-  Notice how when you hold Shift it locks in orientation.
-  When you have chosen your orientation, Whilst holding Shift, click 

on a location on the object.
-  Repeat the above process until you have created section cuts for 

each orientation (Red, Green and Blue)
-  Try right-clicking on each Section Cut and selecting “Active Cut” 

Active Cut is Orange.Selected Cut is Blue.

To activate any Cut, right-
click and select “Active Cut”

C
A5
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Here we’re going to learn about setting up Scenes that display our Plans Sections and 
Elevations..

RIGHT - CLICK 

PLANS SECTIONS & ELEVATIONS: CREATING THE ORTHOGONAL VIEWS 

Our Plan, Section and Elevation drawings 
are orthogonal (Not perspective) drawings. 
Therefore we must ensure that Parallel 
Projection is switched on.

To do this, go to the Camera Menu (top of  
screen) > Choose Parallel Projection.

Make sure you have activated the cut you want to 
set up.
Right-click on the Active Cut and select “Align 
View”

The Aligned View (in Perspective) The Aligned View in Parallel Projection.)

Active Cut1

2

3

4
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Here we’ll finish off the setup of the orthogonal view. We 
want to alter the style of the drawing to our requirements

Click on the second button on the Sections Toolbar to turn 
off Section Cut visibility

Now we’re going to change the appearance of the sliced 
model in three ways:

A Change the infill colour to mid- grey.
B Decrease the thickness of the Outline lines.
C Change the background to white.

These changes are made in the Styles Console/ Dialogue.

TO CHANGE STYLE (See above right)

1. Open the Styles Console in the Default Tray.
2. Click on the “+” button to Create a new Style.
3. Rename the Style to “Section”
4. Click on the Edit tab.
5. Where you see the five edit buttons, click on the 

right-most button.
6. Click on the “Section Fill” colour button.
7. In the Colour Wheel setting, move the slider half 

way to the top to a mid grey colour and click 
“OK”.

8. Change “Section Line Width” to 1 (or leave 
alone if preferred.) 

Section

PLANS SECTIONS & ELEVATIONS: SECTION CUTS & STYLES

TO CHANGE THE 
BACKGROUND COLOUR

- Click on the middle Edit button.
- Click on the Background
Colour Square.
- Choose a white colour for the
background- Move the slider to
the top (See 7 above). 
- Click OK.
- Turn off “Sky” and “Ground”

Turn off Section 
Cut visibility

1

2

34

5 6

8

9

Finally, click the update button (9 above)

Thin Outline

Mid Grey Infill area 
(Note: Section Infill is set to “on”.)

White Background

The final result.

When the circular arrows appear it means you’ve made changes 
that you need to save to the current Style to keep them.

Outline

Infill area

Background

7

Section Fill is turned on.

A
B
C
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Scenes are saved views of the model. They also contain Styles 

and multiple other settings. Previously we created our new Style. 

Now we’re going to create a Scene which incorporates that Style. 

Choosing “Update the selected style” will 
apply any changes to your current Style 
and all Scenes where that style is used.

Section

PLANS SECTIONS & ELEVATIONS: CREATING SCENES 

Top Bar

Setting up your Scene

1. Open the Scenes dialogue in the Default Tray >.

2. Click on the “+”  button to create your new Scene. 

(A new tab with that name will appear in the Top 
Bar.)

3. Edit the name of the Scene in the Scenes 

Browser.

4. When finished, click on the Circular Arrow 
Button to save the Scene.

1

2

3

Updating the Scene is vital before saving the SketchUp 

file. Otherwise our updates won’t appear in LayOut.

 

When creating a Scene that includes Style changes, a 

dialogue appears asking whether to create a new Style for 

that Scene. In general “save as a new style” is the easiest 

option. However, for our purposes in this case, it is easier if 

we use one single style called “Section” that we’ll use in 

every Plan, Section and Elevation.

SketchUp Window

4

A Infill area (Grey Surface)
B Outline (Black Line)
C Background (White)

3 Characteristicss of  our “Section” Style

A

B

C
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PLANS SECTIONS & ELEVATIONS

It is essential to understand how Section Cuts should be grouped with other 
elements.

Why?

We want to be able to control (limit) what elements a Section Cut slices through, 
and what it doesn’t slice through. For example, we may want a Section Cut to slice 
through our building but not slice through the landscape or surrounding buildings.

Below are two diagrams which illustrate the effect of having the Section Cut inside a Group 
vs. having it outside a Group.

2. Section Cut grouped with the 
Orange Object.

Orange Group 
is now cut. 

Blue Group is now uncut.

1. Section Cut ungrouped 
with any object.

The Section Cut slices through 
everything in the model space.

The Section Cut only slices through 
the object that it is grouped with.

Section Cut 
decreases in size to 
correspond to new 
“domain”.

Active Section Cut 
(Ungrouped)

Active Section 
Cut (Grouped 
with Orange 
Object)

Orange Group.

Blue Group.
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Clicking on the 
Home Button 
closes all 
Groups.

Outliner

1

3

4

2

PLANS SECTIONS & ELEVATIONS

Here we’ll organise our House Model Elements into one overall Group so that we 
can integrate our Section Cuts with it.

To begin with, click on the Scene called “Model Only” which displays your model 
with all unnecessary layers switched off. Next, follow the four steps below.

2. Next we want to create one Group for our entire House 
model. To do this in Outliner use CTRL + A (to Select All 
Groups) then right-click on the selection and choose “Make 
Group”.
(Note: The Scene displays only the House elements. All other 
elements are invisible as their layers are switched off.)

4. Next, we want to start placing our Section Cuts 
within the House Group. Right-click on the House 
Group and select “Edit Group”

3. Next, right-click on the new Group we created and 
select “Rename”. Call the Group “House” and hit 
Enter.

1. Open Outliner. First we’re going to exit all Groups. 
The quickest way to do this is to click on the SketchUp 
File Name or Home Button.

RIGHT - 
CLICK 

RIGHT - 
CLICK 

A. CTRL + A*
B. Right-click
C. Make Group.

*(cmd + A for Mac)

RIGHT - CLICK 
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1 Select the “Model Only” Scene.
2 Call up the Section Toolbar as previously outlined.
3 Click on the Section Tool and set up Section Cuts in 

the positions indicated below. (Plan and Section)

Each Section Cut has 
it’s own Name and 
Reference Number 
which can be edited as 
required. The number 
shows up on the Section 
Frames.

Section Entity Number 
here labelled as “9”

Activating the Plan Section Cut and switching off  the Section Frame

Don’t forget to turn on Parallel 
Projection when creating your plans 
and sections. (We’ll set up a shortcut 
for this on page 101.)

The second button on 
the Section Toolbar 
turns on and off visibility 
of the Section Frames.

The position of the Section Cut 
within the organisation of the 
model:

Here we see it is “buried” inside the 
House Group.

Note: We can control where an 
object is located by dragging-and-
dropping it into or out of any Group 
or Component.

Notation for Groups and Components within Outliner are 
explained earlier in the section called “Structuring Your Model”

Model Only

To activate the Section Cut we 
can double-click on it or right-
click-select “Active Cut”

7

PLANS SECTIONS & ELEVATIONS

1

2 3

4

5

6

Section Fill 
is turned on.

SECTION

PLAN

RIGHT - 
CLICK 

SETTING UP YOUR DRAWINGS



Setting Up Your Drawings Page

CONSTRUCTION DOCUMENTS USING SKETCHUP PRO 2020

64Copyright Paul J. Lee 2020

Modelling 
Perspective

Modelling 
Perspective

Clicking “Add” immediately creates a Scene.

PLANS SECTIONS & ELEVATIONS: SCENES

To Activate the Section Cut:

1 Right-Click on it and select Active Cut
2 If you need to reverse direction: Right-Click > 

Reverse

To set up the View:

3 Using the Select Tool right-click on the Active 
Section Cut and select “Align View”

4 Turn off Section Plane Visibility
5 Ensure that Perspective is Off.
6 Use “Zoom Extents” and your mouse wheel to 

frame the view.

To save the Scene in our SketchUp model setup:

7 Right-click on any one of the Scene Tabs above 
and select “Add”

8 Rename the Scene as “Section A - A”
9 Going down the menu, you can activate the 

Scenes Dialogue
10 Using the Scenes Dialogue on the right, Clicking 

on the “+” button also creates a Scene.

The Scenes 
Dialogue is 
thoroughly 
explained on 
the following 
page.

RIGHT - CLICK 

Bringing up this menu also enables you 
to activate the Scenes Dialogue .

Section Fill is turned on.

RIGHT - 
CLICK 

1
2

3

4
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Rename

Rename
8

10
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Rename Scene Here

The Scenes Dialogue

ADD

UPDATE
(Save 
changes)

By default, our Scene contains all the settings we have in place at the time of  
creation. However we can turn each on or off.

Reorder list up or 
down

Expand Dialogue 
to view full list of  
settings (See 
dashed box area 
below.)

DELETE

The Style 
setting is 
included in 
the list here.

Active Section 
Planes are 
saved within a 
Scene.

SELECTED 
SCENE

This dialogue enables you to create, delete, view and edit your Scenes. It contains 
many important settings including Cameral Location and Styles.

SETTING UP YOUR DRAWINGS
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PLANS SECTIONS & ELEVATIONS: SCENES

The Plan Scene

1 Using the Section Toolbar, switch on Section Frame visibility (Second Button)
2 Orbit around to give yourself a three quarter view like that shown below
3 Activate the relevant Cut by right-clicking on the Section Frame to select “Active Cut”.
4 Right-click on the Section Frame again and select “Align View”
5 Turn off perspective (if required) using the “K” shortcut.
6 Zoom into a good position being careful not to orbit.
7 Turn off the Section Frame Visibility.
8 Create a new Scene by right - clicking on the Scene tabs at the top of the model window and 

clicking on “Add”. 
9 You may get a dialogue asking you to Create a new Style. Select “No” to use the “Section” Style.
10 Insert the name “Plan_New” in the Name box in the Scenes Dialogue.

The area highlighted in red 
will require further 
modelling- illustrated later 
on in this book.

Section Frame

Plan_New

RIGHT - CLICK 

Plan_New

1

3

4

Section

RIGHT - CLICK 

5

2

7
8

10

Section Fill is turned on.
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PLANS SECTIONS & ELEVATIONS: SCENES

Setting up Elevations

▪ Turn off  the Active Section Cut (if 
active) to view our model externally. 

▪ Set up the view as follows:

Views Toolbar.

We’ll use Standard Views which are called up in the Views Toolbar.

To call up the Views Toolbar: Right-click on the top of  the SketchUp 
Window (Grey Bar) and select “Views” from the Menu

Click on the Front Elevation Button (See below) to see what we get. (Make 
sure perspective is still switched off- (Hit “K” to check.)

Create the Scene.

Right-click on any Scene Tab at the top of your screen and select “Create 
Scene”.
Right-Click on our new Scene tab and change it’s Name to “West_Elevation”. 
We’ll use this Scene as a template for creating our other elevation Scenes.

In terms of Style, we’ll use the “Section” Style (current)

Activate/ Deactivate 
Section Cut

RIGHT - CLICK 
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Elevations

Elevations 

EastWest

EastWest South

FINISHING THE MODEL: SETTING UP THE ELEVATIONS

Create the Back (East) Elevation:

1 Use the “Elevations” Scene Tab you 
created.

2 Using the Views Toolbar, Click on 
the sixth button from the left to 
create the Front View.

3 Create a new Scene as described 
previously and label it as 
“East_Elevation”

Create the Side (South) Elevation:

4 Using the Views Toolbar, Click on 
the fifth button from the left (Side 
View).

5 This time using the Scenes 
Dialogue, create a new Scene.

6 Name the Scene.

As always, regarding Scenes:

7 If you revise a Scene, always update it, then 
save the SketchUp file again.

8 Save your SketchUp file after creating or 
updating a Scene. (This is vital for updating 
LayOut drawings as we’ll see later.)

Newly created 
“East” Scene

Add Scene

Name Scene

Newly created 
“South” Scene

Side View

Add Scene

Name Scene

The Scene 
Update 
Button

East

South

1 2

4

3

5

7

South_Elevation 6
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TEXTURING THE MODEL

If you don’t see “Materials” on the list of 
menus to the right of your screen in 
what’s called the “Default Tray” then 
you’ll need to add it. This is done by 
selecting Window/ Manage Tray/ 
Default Tray and then selecting the 
“Materials” tick box in the Dialogs list

In order to add color and materials to our model, we’re going to use the Materials browser.

8

The Materials Toolbar Elements:

1 Expand Dialogue.
2 Create a New Material Button.
3 Default Material Icon. (“Default Material” is 

Explained on the next page.)
4 Material Dropper (Copy Material)
5 Select display mode for Current Materials 

Collection: List by name or show as Icons
6 Current Material Name
7 Current Material Texture/ Colour
8 Select & Edit Tabs.
9 Home Button (Press this to show the Materials 

Current in your SketchUp Model.)
10 Name of the Current Materials “Collection”
11 Materials in the Current Collection.
12 Current Material is highlighted with a blue 

border.

11

10

2
7

Materials are accessed via the 
Materials Dialogue or by clicking 
on the Paintbucket Tool.

6
1

3
4

5

12

9
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TEXTURING THE MODEL & ENTITY INFO

ENTITY INFO

There are a number of ways to apply textures. 

Materials are applied to: 

• Individual surfaces or 

• Multiple surfaces at a time. 

Below we have three cubes. The first is ungrouped (Raw geometry), and the second two are 

grouped. Clicking on the Paintbucket Tool allows us to apply a texture (colour) to one face of 

the ungrouped object. If we select another colour and click on the second cube (which is 

Grouped) the entire object changes to that colour. This is because all faces are set to 

“Default Colour”. Default means that all faces will follow whichever colour is given to a 

Group / Component.

Texture applied 

to one face 

only. 

(Ungrouped 

object.)

Texture applied 

to grouped 

object.

Texture applied to a single 

face of grouped object.

Opened Group

When we select any face, line, or Grouped 

Object and right-click to call up “Entity Info” 

we get information on: Material (colour), 

Layer, and Name of the Object.

If we click on the Colour Icon, we can select 

a colour for the object. (Note that line colours 

are controlled in a different way not dealt with 

here.)

RIGHT - CLICK> select 
“entity info”

Ungrouped

Grouped

Grouped

Paint Bucket Tool

SHOW/ 
HIDE 
OBJECT

LAYER PULL DOWN MENU

GROUP NAME

LOCK/ 
RELEASE 
OBJECT

CAST 
SHADOWS 
ON OBJECTS

CAST 
SHADOWS 
ON GROUND

BIM Classification

SETTING UP YOUR DRAWINGS
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TEXTURING THE MODEL

Now let’s texture a few surfaces, starting 
with the main roof. 

1 Call up Outliner and select the “Roof_01” 
Group that we created earlier. Open the 
Group with a right-click or a double-click.

2 Activate the Paintbucket Tool.
3 In the Materials Browser, select the Home 

Button
4 Click on the Material called 

“Rooftile_Dark” as illustrated
5 Click on the upper surfaces of the roof to 

apply the texture.
6 When finished, close the Group. 

(Remember the quickest way to close all 
Groups is to click on the main model or 
“Home” Icon.)

Roof_01

“ROOFTILE_DARK” MATERIAL

To finish: RIGHT - CLICK on empty 
background outside of bounding box 
and select “close group” or click on 
main model icon in Outliner as 
detailed above.

Rooftile_Dark

Clicking on the 
Main SketchUp 
File Icon closes 
all Groups.

right-click or double-
click to edit group

1

2
3

4

5

6
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TEXTURING THE MODEL

To texture the tiled areas: 

1 Open up the view of the interior by 
clicking on the “Plan_New” Scene Tab.

2 Turn on Perspective using “K”
3 Orbit around to (approx) the view shown.
4 Save this as a new Scene. Call it 

“Plan_Perspective”.
5 To access the Floor Group, find 

“Slab_GF” in Outliner and open for 
editing.

6 Draw lines that mark out the areas on the 
floor surface that you wish to tile such as 
the kitchen and WCs (Use “H” shortcut to 
toggle on and off walls to infer.)

7 Activate the Paint Bucket Tool 
8 In the Materials Browser select “Tile” 

from the Collection Pulldown Menu.
9 Select a tile pattern.
10 Click on the selected areas to apply 

Texture.
11 Close the Group. This time right-click on 

a blank space outside the Group 
surrounding box to select “Close Group”

12 As always, save your model file.

double-click & right-
click > make group

Plan_Ne
w

Plan_New1 2

3

Plan_Perspective

4

5
6

double 
- CLICK

8

1

7

9

10
RIGHT - CLICK 
close group

11
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Turn on Section DisplaySketchUp Model: Scene “Section A - A”

1 Opening the SketchUp file let’s go to the Section A - A Scene.
2 Turn on Section Display

1 2

FINALISING THE MODEL FOR LAYOUT

We’ve set up most of the views that we want, and textured the model. However we haven’t included the 
landscape and surrounding context which we’re now going to do. The landscape is already in place on a hidden 
layer. However, as we can see in the images below when we switch the layer on we can see that it obscures 
the house. Our Section and Elevation drawings all require that we “slice” through the landscape.

Adding in the landscape creates the need for extra Section Cuts to cut through the ground plane.

Section A - A

Elevation in 
isolation

Landscape layer is 
switched off.

Elevation with 
landscape

Landscape layer is 
switched on. 
Ground is not cut.

Elevation with 
“cut” landscape

Landscape layer is 
switched on. 
Ground is cut.

A B C

Ensure the 
Section Fill 
is turned on 
also.

SETTING UP YOUR DRAWINGS
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Notes &  Dimensions

In our model space there’s an invisible layer which was set up to contain the landscape geometry. We’re going 
to switch on that layer, create the Section Cut and then line up our view so that it’s fully complete for use in 
LayOut. 1 Before proceeding, ensure that all Groups are 

closed- Click on the Home Button in Outliner.
2 Orbit and zoom out to (approximately) the 

viewpoint illustrated here.
3 Expand the Layers Dialogue.
4 Turn on layer called “A_Hidden_Landscape”

A_Hidden_Landscape

5 Using the House Group for alignment, Create 
a new Section Cut that will slice through the 
entire model. (The original Section Cut 
remains current.)

6 Note the visibility of the new Section Cut in 
Outliner.

7 Right-Click on the new Section Cut and select 
“Align View” and then zoom into position.

8 Turn off Section Cut visibility.
9 Right-Click-Update the “Section A - A” Scene.
10 Save the SketchUp file.

2

3

RIGHT - 
CLICK 

6

Right Click 
on Section 
Cut and 
select “Align 
View”

Highlighted Section Cut is blue.

Section A - A

Section A - A

Section A - A

7

We’re updating the Section Planes so we need to have this box ticked. 
(It’s normally ticked by default.)

Section A - A

House

9

1

4

5

Section 
A:A

8 RIGHT - CLICK 
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Elevations EastWest South

FINISHING THE MODEL: SETTING UP THE ELEVATIONS

Inserting the landscape into the elevation drawings.

Now that we’ve set up our three elevations, we need to set up the corresponding landscape in order to finish 
off the external levels. 

1 Click on the “West” Scene that we set up previously.
2 Go to the Layers Browser and click on 

“A_Hidden_Landscape” which will now obscure the 
view.

3 Bring up the Views Toolbar and click on the Isometric 
Button.

4 Click on the Section Cut Button and float your cursor 
onto the front wall of the building and then hold down 
the Shift Button.

5 Click on the ground plane just in front of the building 
and you should see the ground sliced away.

A_Hidden_Landscape

1

2

5

3

4

SETTING UP YOUR DRAWINGS
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Previous

Camera/ Previous

Shortcuts

1. Select Window/ Preferences/ 
Shortcuts. (SketchUp > 
Preferences > Shortcuts for 
Mac)

2. Type “Previous” into the filter 
search.

3. Click on the selection called: 
Camera/ Previous

4. Type “J” into the “Add 
Shortcut” Dialogue and click 
on the “+” button.

5. If you’re asked if it’s OK to 
override an existing function. 
Select “Yes”.

Now the shortcut is ready. Test the 
effectiveness of the shortcut by 
hitting the the “J” key and see how 
the 5 previous views are displayed in 
sequence.

SketchUp saves 5 previous locations from which you were 
viewing the model. The way to cycle backwards through these 
locations is via Camera > Previous. This is very useful in a 
number of ways which will become apparent as we proceed.

J

J1

2

3
4

CREATE “POWERFUL SHORTCUT No. 3”
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Camera
Previous

South_Elevation

FINISHING THE MODEL: SETTING UP THE ELEVATIONS

Having set up the Section Cut for our Elevation:

1 Click the Section Cut Display Button to turn off 
the Cuts.

2 To return to the view back to where we had it 
previously, hit the “J” key. Keep pressing until 
you get to the Elevation view you had previously.

3 To save the changes to the Scene, click on the 
Update Button on the Console.

4 Repeat the process for the other two elevations.
5 An alternative approach to setting up our 

elevation we can use the Section Cut as a 
reference: Right-Click on the Section Cut and 
select “Align View”.

6 Remember to resave the Scene.

Section A - A

Section A - A

RIGHT - CLICK>
ALIGN VIEW

1

5
6

7

3

2

RIGHT-CLICK
UPDATE SCENE

SETTING UP YOUR DRAWINGS
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Landscape Perspective
Add Scene

Perspective 1

Landscape Perspective Perspective 1
Add Scene

Perspective 2

FINISHING THE MODEL: SETTING UP THE PERSPECTIVES

1 Click on the Landscape Perspective Scene Tab. (This Scene is saved with all Section 
Cuts switched off and all layers switched on.)

2 Orbit to your preferred viewpoint.
3 Right-click on the Scene Tab and select “Add Scene”
4 Right-click on the new Tab and select “Rename”
5 Call this Scene “Perspective 1”
6 Repeat to create further Perspectives 2, 3 etc..
7 As always, save the SketchUp file.

To finalise the Scenes we’ll use a Scene Tab that has no Section Cuts: The Landscape Perspective.

• RIGHT - CLICK
• add scene
• RIGHT - CLICK
• rename scene 

1

2 3 4

5

6

SETTING UP YOUR DRAWINGS
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There were a couple of things we needed to finish in the model. They were:

• Remodelling to the entrance area of the house

• Completion of the party (North) wall.

• Creating the Ceiling Group

• Fixing the floor slab (if needed).

• Create openings for Skylights in the roof.

THE ENTRANCE AREA: WALL

To model the step down in the wall at the front entrance:

1 Using Outliner (or using your mouse to right-click-select), Open the “Walls_Ext” 

Group. 

2 Draw a line onto the surface of the Wall as indicated.

3 Push-pull the surface to level with the bottom of the door.

4 Close the Group (Hint: Click on the House Icon in Outliner to exit all groups 

quickly.)

THE ENTRANCE AREA: FLOOR

Plan_New

MODELLING THE HOUSE: FINISHUP

1

2

3
4

1

To model the step down at the floor in the front entrance:

We’re going to get a clear view of the floor by clicking on 

the “Plan_New” Scene that we created  previously. 

Turn on Perspective: Hit “K” (Shortcut we set up earlier)

Go to the next page.

This is the 

area we’re 

going to 

remodel.
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1. Orbit around to the front entrance. Open Outliner 
and edit the Ground floor slab “Slab_GF”

2. Create a construction line that coincides with the 
width of the front door.

3. Draw a rectangle to reflect the shape we’ve just 
outlined.

4. Use push pull tool to create a hole in the slab.

5. Pressing the “H” shortcut enables us to view the 
slab in isolation.

6. Orbit to the underside of the slab. Draw a new 
rectangle into the location as shown here and create 
a step down.

THE ENTRANCE AREA: MODELLING THE FLOOR SLAB

MODELLING THE HOUSE: FINISHUP

Draw an “infill” 
rectangle here and 
then push-pull to 
create the step 
down in the slab.

1

2

3

4

5

6
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1. Offset the outlines of the slab inwards by 300mm

2. Push-pull the “border” area to line up with the bottom of the step.

3. Delete all unnecessary lines. 
When finished, exit all Groups by clicking on the Home Button in Outliner 
(Next we’re going to edit the Gable Wall.)

4. Now we’re going to shape the gable wall by extending it up and using the 
roof to “slice” it.

5. Orbit around to view the North end of the model. Using Outliner, open the 
“Roof_01” group. Holding down the CTRL key, push-pull a surface from the 
roof edge and close the Group.

6. Open the “Walls_Ext” Group from Outliner. Draw lines on the top of the 
gable wall as indicated.

THE ENTRANCE AREA: MODELLING THE FLOOR SLAB & THE GABLE WALL

MODELLING THE HOUSE: FINISHUP

1

2

3

4

5

6

Create a “copy” of the 
roof edge using Push-Pull

ctrl

Draw lines to “break” surface

Area to Push-Pull
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1 Push-pull the top wall surface 
up above the level of the roof 
surface (The roof isn’t visible 
here as we’re using the “hide” 
function.) 

2 Select the surfaces that you 
need to slice (Use a right-to-
left drag rectangle selection) 

3 Right-click on the surface and 
select “Intersect With Model”

4 The result is the “splitting” of 
the wall surfaces.

THE ENTRANCE AREA: MODELLING THE FLOOR SLAB & THE GABLE WALL

RIGHT - 
CLICK 

MODELLING THE HOUSE: FINISHUP

To delete the surfaces we don’t 
need:

5 Using the Select Tool, drag 
from right to left across the 
surfaces to highlight them as 
indicated.

6 To make them easy to delete 
we can make them a group 
(This means we don’t 
accidentally delete lines that 
other surfaces depend on.) 
To do this, Right-click on the 
selection and pick “Create 
Group”

7 With the Group highlighted, 
click on the Delete button 
(On your keyboard.)

8 With all surfaces deleted, 
Close the Group

9 Delete any stray lines or 
surfaces.

right to 
left drag

1

2

3

4

right to 
left drag

5
6

9

8
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Paste

Edit/ Paste in Place

Shortcuts

Z

Z

1. Select Window/ Preferences/ 
Shortcuts. (SketchUp > 
Preferences > Shortcuts for Mac)

2. Type “Paste” into the filter search.
3. Click on the selection called: “Edit/ 

Paste In Place”
4. Type “Z” into the “Add Shortcut” 

Dialogue and click on the “+” 
button.

5. If you’re asked if it’s OK to override 
an existing function. Select “Yes”.

SketchUp has a special paste function that is specific to 3D modelling context. It allows us 
to copy an object and paste it exactly into position. We’re now going to create a shortcut for 
this using the letter “Z”.

Now our shortcut is ready. Test it’s effectiveness: 

1 Start a new SketchUp file. 
2 Create a box.
3 Select and copy one of it’s surfaces (CTRL + C)
4 Start another SketchUp file.
5 Press “Z”
6 The surface should be in the exact same place in the new file.
7 Test it’s positioning by copying another of the cube’s surfaces in the same way 

repeating the process. The surfaces should line up perfectly.

This shortcut should be used constantly throughout your day-to-day modelling. Note 
that it can also be used between different files. This is a very useful technique for 
modelling a large SketchUp file to speed up modelling: Take a piece of geometry 
you’re working on and paste it into a new file. Keep working on it there and then copy 
paste in place back into the original file.

CREATE “POWERFUL SHORTCUT No. 4”

1

2

3
4

1. Select a 
surface to 
copy

2. Select a 
second 
surface to 
copy
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Perspective

Camera/ Perspective

Shortcuts

K

K

1. Select Window/ Preferences/ 
Shortcuts. (SketchUp > 
Preferences > Shortcuts for Mac)

2. Type “Perspective” into the filter 
search.

3. Click on the selection called: 
“Camera/ Perspective”

4. Type “K” into the “Add Shortcut” 
Dialogue and click on the “+” 
button.

5. If you’re asked if it’s OK to 
override an existing function. 
Select “Yes”.

SketchUp generally works best when viewing your model in perspective. We’re going to set 
you up with a shortcut that toggles between orthographic and perspective.

CREATE “POWERFUL SHORTCUT No. 5”

1

2

3
4

Click on 
“Section A - 
A” or Plan/ 
Elevations.

Hit “K”.

Hit “K” again.

Now our shortcut is ready. Test it’s 
effectiveness: 

Click on any orthographic scene in your 
model (Plan/ Section/ Elevation)
Hit the “K” key.
Notice how the drawing becomes a 
perspective.
Hit the “K” key again.
You’re back to Parallel View.

This shortcut will be used constantly 
throughout your day-to-day modelling. 
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3 Select the floor surfaces. Using Select Tool, while holding 

down Shift to select multiple surfaces, select all floor surfaces. 

Don’t select the Sun Room extension floor surface.

4 Use CTRL + C to copy.

5 Close the Slab Group. (But don’t close the House Group. The 

ceiling needs to be kept inside the Group.)

6 To generate the next vantage point Click on the “Section A - A” 

Scene.

7 Press “Z” (Our Paste In Place Shortcut)

8 Turn on Perspective: Use the “K” shortcut to bring up 

Perspective View.

9 Create a Group (The pasted geometry is still selected) Right 

Click > Make Group

10 Using Outliner or Right Click Entity Info Name the Group as 

“Ceiling” (Check that it’s inside the House Group.)

11 Move the ceiling upwards into position as shown. Use the Up 
Arrow on your keyboard to lock movement into the blue 
(vertical) axis.

12 Open the Ceiling Group.

13 Press “H” shortcut to view the ceiling slab in isolation.

14 Turn off Section Cut to see the full Group.

15 Delete all internal dividing lines (if any)

16 Using Push-Pull Give it a thickness of say 25mm for a double-

slab plasterboard. Close the Ceiling Group.

1 Click on the “Plan_New” Scene 

2 Using Outliner open “Slab_GF” Group. (Or double-click 

twice to drill down into the Group.)  

MODELLING THE CEILING

Plan_New

Section A - A

10

11

double 
- CLICK

12

13

16

14

15

To create the ceiling, we’re going to 
copy the floor surfaces which are 
the same shape.

MODELLING THE HOUSE: FINISHUP

A

B

C

D

E

1

2

3 CTRL + C4

6

7

Ceiling gets pasted 

into place here.

RIGHT - CLICK - 
Make group

double 
- CLICK

Move the ceiling 

up into position

Open the Group 

and edit thickness 

to 25mm

Always 

remember to 

close the 
Group when 

you’re finished.

8

9

RIGHT - CLICK - 
close group

5
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Name this Component 
“Top Roof  Opening”.

Ensure that “Cut 
Opening” is ticked. 
“Replace selection 
with Component” 
should be ticked.

Create Component.

We’re going to use the shape as an 
outline for cutting through the roof  
surface:
 
Open the Component by double 
clicking on it.
 
Erase the inner surface of  the shape.

View of the Skylights that we inserted previously.

To create an opening:

Using the Select Tool: 
Double-click on the shape.

Right-click and Make it a 
Component

(Previously for doing this 
we just used the Push-Pull 
Tool. Here we have “tricky 
geometry” that isn’t doing 
what we want so we’re 
using a different method to 
create the opening.)

Close the 
component- 
Right-click 
outside the 
component 
and select 
“Close 
Component”

The Component is 
finished and ready to 
copy.

Select the 
shape (edge)
Move-copy it 
onto the 
lower surface 
of  the roof.

(We’ll position 
it exactly 
later.)

We’re going to cut holes in the roof surfaces that correspond with the roof lights. 
To begin, select the “Model Only” Scene and navigate to a view approximating (1) below.

Only the 
lines are 
left.

MODELLING THE ROOF OPENINGS AND “SKY FUNNELS”

> Open the “Roof_01” 
Group using Outliner.
> Select the Rectangle 
Tool.
> Holding down Shift 
Button lock the cursor 
onto the roof  surface
> Use the roof  light as 
an inference to draw a 
rectangle from corner 
to corner 
onto the roof  surface.
> Orbit around to the 
far side to place the 
second point.

double 
- CLICK

RIGHT - 
CLICK 

MODELLING THE HOUSE: FINISHUP

1

2

3

4

5

6
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Activate “H” shortcut.
Orbit to a view of  the roof  from the underside.
Use inferencing to line up the two corresponding 
shapes

Move-copy the two shapes to create a 
new double opening.

NOTE: You need to do this one at a 
time or else the cut doesn’t work. 
(Some technical reason for this.)

Pressing “H” shortcut makes the skylights reappear. 
This allows for lining up the openings.

Now we’re going to start modelling 
the “funnel” shape.

We’ll create a new separate piece of  
geometry using the opening as our 
inference.
 
Here we go inside the roof  and using 
the Rectangle Tool draw a shape 
over the underside opening.

Double-click on the shape. 
Right-click Make a component 
called “Skylight Plasterboard”.

Double-click on the Component to open it. 
Push-pull the shape through the ceiling.

MODELLING THE ROOF OPENINGS AND SKY “FUNNELS”

MODELLING THE HOUSE: FINISHUP

1

2

3

4

5

6

double - 
CLICK

RIGHT - 
CLICK 

double - 
CLICK
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Use “H” to hide rest of  the model.
Orbit to the underside of  the shape.
Double-click on the underside surface.

Click on the Scale tool to make the Grips appear. (Green boxes.)
Holding down the CTRL button (Alt for Mac) Pull across the centre 
grip to expand the shape size.
Do this in both width and length directions. Use “H” to turn on and off  
the building view.

Hide environment using the “H” button.
Triple-click on the shape to Select All - or - Use CTRL + A - or - Use a L 
- R capture selection. Right-click on the selected shape and select 
“Intersect faces with Model”

With a Right to Left Crossing Selection, select the area 
as indicated above.
Right-click on the selection and select Make Group.
Delete the Group. Now the funnel shape is complete.

Now we’re going to switch the orientation of  the surfaces 
(They’re inside-out. We want the inside faces to appear white.) 
Select the entirety of  the shape as before.
Right-click and select “Reverse Faces”.

Faces are orientated as desired.
Push-pull the surfaces outwards by 25mm to create 
a thickness for each side.
Close the component.

Now we’re going to get rid of  the part of  
the funnel that cuts through the ceiling.

Delete 
the top 
face

MODELLING THE ROOF OPENINGS AND SKY “FUNNELS”

double 
- CLICK

Centre 
Grip
appears
.

Result

triple 
- CLICK

RIGHT - 
CLICK 

RIGHT - 
CLICK 

RIGHT - 
CLICK 

25mm

MODELLING THE HOUSE: FINISHUP

1

2

3

4

5

6

Drag from 
top-right to 
bottom left.

Drag-
select
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Copy-Move the funnel shape to 
line up with the adjacent opening.

As with the roof, create a Component that cuts through 
the ceiling surface.
Delete the internal surface.

Copy the opening to the upper surface of  the ceiling.
The opening is complete.

Move-copy the openings to line up with the adjacent 
funnel.
Close the Ceiling Group.

Orbiting to to look at the top of  the roof  
we can see right through to the floor 
inside.

Orbit to the underside of  the ceiling. You can see the 
outline of  the funnels cutting through the ceiling above.
Open the Ceiling Group.
Draw the shape of  the outline of  one of  the funnels onto 
the ceiling.

MODELLING THE ROOF OPENINGS AND SKY “FUNNELS”

MODELLING THE HOUSE: FINISHUP

1

2

3

4

5

6
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Let’s take a look at our model:

1 Close all Groups.
2 Click on the “Landscape Perspective” Scene. 
3 Save your model (CTRL + S)

Landscape Perspective

 
1

If you’ve reached this point successfully congratulations! We’ve now completed the overall 
building model and are ready to tackle the detail models and finally the drawings in 
LayOut.

To close all 
Groups, Click 
on the “Home” 
button in 
Outliner.

CTRL + S
3

If you’ve reached this point 
successfully congratulations! 
We’ve now completed the 
overall building model and are 
ready to tackle the detail 
models and finally the drawings 
in LayOut. MODEL END RESULT

2

MODELLING THE HOUSE: FINISHUP
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DETAILS MODEL FILE

In your downloaded files you’ll find the file 
called “Construction Documentation 
SketchUp Pro_Details_X.X”

With this file we’re going to build the details 
that accompany our House Model.

Here’s what our Model file looks like:

Opening the file, we have 
the “Overview” Tab which 
shows the various drawings 
and illustrations that we’re 
going to refer to. Contents 
are as follows:

✓ An Elevation 
drawing

✓ A Section drawing
✓ A Perspective 

Image.
✓ 3 Building 

Components
✓ A Modelling Area.

MODELLING THE DETAILS

We’ll draw onto 
the image Plane

We’ll create the model here.
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Modelling Perspective

To create our drawing, we’re 

going to generate a wireframe 

from the model as follows:

1 Click on the Scene 

“Modelling Perspective”

2 Switch on Section 

Display

3 Using Outliner, Right-

Click on Section A - A

4 Select “Create Group 

From Slice”

5 This Group appears in 

Outliner.

6 Copy it (CTRL + C)

OBTAINING A SECTION DRAWING FROM THE MODEL

Let’s go back to our House Model.

Now lets go to the Details Model.

7 Paste in the Section Group that we copied 

from the Model.

8 Place it on the origin as illustrated here.

9 Move it into place over the Section 

Drawing.

Float the line drawing over the image as illustrated. We’ll 

use these lines as the basis to form geometry for building 

the details.

1 2

RIGHT - CLICK 

3

5

4

9

8

Placing the 

drawing here first 

ensures that it’s on 

the correct “plane”.

MODELLING THE DETAILS
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CREATING THE EXTRUSIONS FROM THE DRAWING

MODELLING THE DETAILS

Let’s draw the top part of the 
glazing (Transom)

1 Using the Rectangle Tool, 
trace over the drawing to 
create a square.

2 Use Offset to create the 
inner square @3mm 
thickness.

3 Use the Tape Measure 
Tool to find the mid-point 
of the shape to set out the 
cut for the glazing (6mm)

4 Extrude the part to about 
2m length.

5 Using Select Tool triple-
click to select the 
geometry.

6 Right-Click and make it a 
Group.

Approx 2
m long.

1

2

3

triple 
- CLICK

4

5
RIGHT - CLICK 

6
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BUILDING ELEMENTS FROM THE DRAWING

MODELLING THE DETAILS
1 Using the Line Tool trace 

over the boards to create 
separate regions as 
illustrated.

2 Double click the internal 
region of a shape to select it.

3  Right-Click Make Group with 
each one.

4 Open Groups to extrude (See 
illustration below.)

5 Close Groups.

Draw the lines as illustrated (no 
precise angle to the roof- visual 
accuracy only.)

double 
- CLICK

RIGHT - CLICK 

1 2

3 4

6 Using the Paint Bucket Tool 
activate the Materials 
Browser.

7 Click on the Home Button to 
view the native list of 
materials.

8 Choose Metal and Wood for 
the elements as shown.

6

7

8

Double Click 
on internal 
surface to 
select.



Modelling Details Page

CONSTRUCTION DOCUMENTS USING SKETCHUP PRO 2020

95Copyright Paul J. Lee 2020

BUILDING ELEMENTS FROM THE DRAWING

2

MODELLING THE DETAILS

1 Activate the Components 
Browser on the right of 
your screen and import 
the “250mm H-Beam” into 
position. (Click on the 
Home button to bring up 
native Components.)

2 With the beam selected, 
activate the Scale Tool.

3 Drag the middle handle 
outwards to lengthen the 
beam to the same length 
as the mullion.Drag the Middle 

Grip to lengthen 
the beam.

1

3

4 Draw the shapes of the 
rafters and “firring pieces” 
that fit around the H-
Beam.

5 Create separate Groups 
for the Rafter and the 
Firring Piece.

6 Selecting both Groups 
create a Component, 
called “50 x 250mm 
Rafter”.

7 Use Move-Copy to create 
a copy of the Rafter @ 
400mm as specified.

8 Type “4X” and hit Enter to 
create an array.

9 Draw and extrude the 
insulation.

RIGHT - CLICK 

4X

4
5

7

8 9
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MODEL THE INSULATION, BATTENS & CEILING

MODELLING THE DETAILS

To Create the Insulation Battens: 

1 Taking the rafters we created, let’s re-
open the Rafter Component.

2 Select both Groups inside, holding 
down Shift to do this.

3 CTRL + C to copy them.
4 Close the Component.
5 Paste in Place (“Z” shortcut.)
6 Move the elements into place.

7 Texture both pieces: 
8 Using the Paint Bucket Tool while 

holding down alt to activate Sampler, 
take a sample of the insulation batten 
that’s located in the “Building 
Components” section.

9 Paint the texture onto both Groups.
10 As they’re selected, incorporate both 

Groups into a new component called 
“Insulation Battens”

11 Move-Copy the new Component into 
place as illustrated.

12 Type “3x” and hit Enter to create an 
array of the Battens.

13 To create the underside Ceiling 
Battens, draw a 50 x 40mm rectangle 
in place.

14 Extrude the rectangle to the length 
indicated.

15 Triple-click/ Right-click to create a 
Component called “Ceiling Batten”.

16 Sample and use the “Wood” Texture 
as described above.

17 Move-Copy to array the battens as 
indicated@ 435mm centres .

RIGHT - CLICK 

18 Draw the Ceiling profile and extrude it. 
19 Texture using the Plaster texture this time from the 

Materials Browser.

6

8 9 11
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IMPORT AND POSITION VARIOUS COMPONENTS

MODELLING THE DETAILS

_Steel 
Bracket 
AssemblyDoor_External

_Glazed

90 x 38mm S/S 
Box Section

Drainage 
Channel

Metal 
Cover 
Profile

We’re going to use a few in-built Components to create our details. Their names are listed 
in the illustration below. Using the Components Browser, click on the Home button to find 
the list of Components. Import the 5 listed below. Place them casually first and then use the 
drawing to finally position them.

Metal Cover 
Profile

Grille

Draw each region, 
creating Groups 
as you go. Texture 
each appropriately 
as per illustrations.

90 x 38mm S/S 
Box Section

Ground Level Profiles ▪ Update the 
Scenes if you 
have made 
adjustments.

▪ Save your file.
▪ Next we’re 

going to import 
our Scenes 
into LayOut.
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LayOut is the graphic interface for SketchUp models. 

LayOut’s vector line capabilities include scaled drawing functionality which facilitate export 
to PDF, DWG, DXF as well as .jpg and .png file types. Menus and dialogues contain a vast 
array of options for customising lines, linetypes, shapes, infills, dimensions and text. 

Vector-based 
drawings with 
customised 

dimension styles.

Customised Drawing 
Titles Styles & Notes 
are saved for instant 

access in the 
“Scrapbook” Dialogue 

(described later.)Customised 
Titleblocks saved as 
templates which can 

be set to automatically 
open on startup.

SketchUp models are scaled within LayOut. Dimensions, graphics and 
notes are then applied. This section of the book illustrates using 
LayOut to achieve final drawing production from our model.

Here is the first of the sheets we’re going to produce:

DRAWING PRODUCTION: LAYOUT
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Let’s select Titleblock- A3 Landscape

Construction Documents Using 
SketchUp Pro
Date & Time

Construction Documents Using 
SketchUp Pro
Date & Time

Construction Documents Using 
SketchUp Pro
Date & Time

A4 Landscape A3 Landscape A2 Landscape A1 Landscape A0 Landscape A4 Landscape

Initial LayOut View.

Double-click on the 
A3 Landscape 
Template to open it.

On starting up, LayOut initiates the dialogue below. 
We have two main choices:

1 Open a pre-set template (There are various categories to choose from.)
or….

2 Select from the previously saved files listed.

List of recent LayOut files

DRAWING PRODUCTION: LAYOUT

1

2
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INSERTING THE SKETCHUP MODEL To insert a Model:

1 Go to: File > Insert.
2 Select our SketchUp file that we’ve 

been working on.
3 The SketchUp Window appears in 

LayOut showing the view of the model 
that was current when we saved it.

4 Right-click on the window and go to 
Scenes to select the Scene you wish 
to view from the pull down menu.

Construction Documents SketchUp Pro 
20xx

Resizing the Window:

With the SketchUp Window selected (highlighted), 
float the mouse around the Window and notice the 
different icons appearing over the model and on the 
edges. Drag the edges or corners to resize the 
window as illustrated in the example here.

Repositioning the Window

When you float the mouse over Model Window the 
Crosshairs appears. When this happens, hold the 
mouse button down to drag the Window into position.

SketchUp Window
Resize Window by dragging edges or corners.

Reposition Window by 
dragging it with the cursor.

LayOut Titleblock

1

2

3

RIGHT - CLICK - 
scenes - select

Scene X
Scene Y

—————
—————
Scenes
—————
—————4

The central icon 
allows you to 
rotate the 
window by 
dragging the 
“handle”

DRAWING PRODUCTION: LAYOUT
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LayOut allows us to display our models to scale and to apply accurate graphics. 

We’re going to scale our Model Scenes and then apply graphics, dimensions and notes. To do this we need to 
accurately infer linework in the drawings. For this we require Object Snap to be switched on. It’s normally 
switched on by default but lets check:

Go to Arrange > Object Snap to see that it’s ticked.

CALLING UP THE “A - A” SCENE:

To present a Scene that we’ve prepared in SketchUp:

1 Right- Click on the SketchUp Model Window
2 Select “Section A - A” from the dropdown menu. The Scene should now be displayed.

Selecting a Scale for the Scene.

3 Right-Click on the Section A - A Scene as above and select “Scale” from the dropdown menu.
4 Select “1/100”. (Note that when a scale is chosen, we can then resize the window  without the scale 

being changed. This setting can be turned off to allow dynamic rescaling- We’ll see how that works 
later.)

———Object Snap

RIGHT - CLICK 

———
Section A - A

RIGHT - 
CLICK 

———
Scale

———
1 : 100

1 2
3

4

Object Snap is required 
to “Grip” lines and 
endpoints in your 
SketchUp Model. 
It enables us to accurately 
apply graphics and 
dimensions to our model.

DRAWING PRODUCTION: LAYOUT
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Shape Style Dialogue 
controls options for:

• Line Colours
• Line Thickness
• Line Types
• Arrow Types
• Arrow Sizes

The Dimension Style 
Dialogue provides options 
for:

• Text Position
• Leader Style
• Scaling
• Dimension Units

Creating the 
Dimension: Click 
onto node points 
in the drawing.

Use Dimension Style and 
Shape Style dialogues to make 
adjustments.

TO CREATE DIMENSIONS: Click on the Dimension Tool button (1) and then click on your two 
reference points (2, 3). The next point (4) will locate the text and the arrows. Select the dimension to activate 
move function (5). 

MORE ABOUT EDITING 
DIMENSIONS ON NEXT PAGE

25
70

 m
m

25
70

 m
m

2

3

4

5

1

36 mm

Leader 

Drag text to create curve, or:
Straight leader
No leader

LAYOUT: DIMENSIONS
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Orientation and positioning of  text.

Dimensions will automatically update in 
response to changes in the associated 
SketchUp model.

On selecting a dimension object, it will display various 
grips (blue colour) that allow it to be repositioned.

Type text here

Drag the blue (highlighted)  elements to reposition the 
Dimension.

Drag the blue 
dot handle to to 
rotate around 
Central Point.

Selected (highlighted) dimension

Text Style and 
Colour is controlled 
by the Text Style 
Dialogue.

double - CLICK to 
edit dimension

Angled Dimension Leaders

Drag text to reposition and 
auto-generate Leader

15 m
m

Using CTRL while  
dragging left mouse 
button enables 
perspective and 
isometric 
dimensions
(Alt + Mouse Button 
for Mac)

[Bespoke Text] 18 mm

Updates in LayOut 2019

<>

Bespoke Text with Auto-Dimensions
1 Double-click into text.
2 Write your text before the “<>” symbol.
3 Click away.

double - CLICK to edit text

18 mm

1

2

Central Point (Can be dragged into 
new position as an inference point.)

Float mouse over dimension to 
see cross appear. Drag 
dimension to reposition.

click away

3

LAYOUT: DIMENSIONS
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Here we’re going to create a shape using the SketchUp model’s node points to generate a 
shape for the ground that is cut away.

1 Click on the Line Tool and then click on all the node points in your drawing that relate to the cut in the ground.
2 Complete the profile shape as illustrated.
3 Open the Shape Style Dialogue on the right.

select

25
70

 m
m

0.25

4 Select the outline shape for editing.
5 Turn on Fill.
6 Stroke Colour: Turn on and Select Black.
7 Stroke Thickness: Set to 1 Pt.
8 Click on the Pattern Button.
9 Select “Material Symbols” from the dropdown menu.
10 Select “Brick Common Face” 
11 Select Scale: 0.25

25
70

 m
m

Create a “box” 
which 
incorporates 
the Model’s 
Node Points

6

8

4

1

2

3

5

9
10

11

7

LAYOUT: SHAPES & INFILL
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Bounded/ 
Unbounded Text

Colour 
Selector

Horizontal Justify Text

Vertical 
Justify 
Text

Font Type Size

Underline &
Strikethrough

To start creating text click on the text button or hit “T” shortcut.

The Text Style Dialogue presents options for colour, 
font, size and others. This interface controls text used 
in Dimensions also.

Text Style can be edited by single-clicking on it and 
making changes via the Dialogue. 

Text content is edited by double-clicking on the text box, 
editing and then clicking away to finish.

TEXT

TEXT

SETTING OUT THE TEXT

Creating text is generally done in one of three ways: 

1 Basic line input 
2 Setting out text boxes.
3 Using Call-outs

Single-click and type text. Click away 
to finish.

Create a text box by dragging and then 
type. Click away to finish.

1

2

3

 TEXT

• Click on the call-out icon
• Select a start point, mid point 

and text input point. (A, B, C)
• Click away to finish.

A

B C

D

LAYOUT: TEXT
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Text/ Inserted 
SketchUp Model.

SECTION A - A

Moving the Text:
As you float your mouse over the text, the cursor changes to a 
cross. Reposition the text box by dragging on it.

Font: 
Avenir
Medium
24 
Point.

25
70

 m
m

Stretching & Rotating Text:
Text boundaries are reshaped, moved and rotated in the same 
way as shapes. They can also have fills and boundaries (See 
previous section regarding “Shapes”.)

Selected 
Text Box.

Auto-Text is used to automatically change in response to 
inputs such as page number, page name, date etc. It is 
written as a kind of “code” like this: 

<text inside brackets>

Practical examples are 
 PageNumber Auto-displays page number.
 PageName Auto-displays page name.
 DateCreated Auto-displays date created.

Date Auto-Text Project (File) Name Auto-Text

Page Number Auto-Text

SETTING OUT THE TEXT

Drag to 
rotate 
text box

Drag to resize text box

Drag to 
reposition 
text box

Double-click to edit text

Drag to 
reposition 
anchor

You can edit auto text inputs by clicking on the Top Page 
Menu: 

Go to: Text > Customise Auto-Text

There you’ll see the listed auto-text options in the 
Document Properties Console.

You can also create your own Auto Text categories by 
clicking on the “+” button. There are also “duplicate” and “-” 
buttons.Auto-Text Console.

Note: The text must be written exactly 
with first letter as a capital with no spaces

< 
< 
< 

< 
< 

< 

<Auto-Text>

LAYOUT: POSITIONING & SIZING
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Scene 2
Scene 1

PLAN Scale 1/100

Perspective from West

Perspective from East

Plan/ Perspectives
Sheet Size: A3

Notes: ……………..
 ……………..
 ……………..

Style Settings for the Dimensions 

Font: 
Avenir Medium, 
20 Pt.

Font: 
Avenir Book, 
14 Pt.

Font: 
Avenir Medium, 
10 Pt.

1 Float your cursor over a window until you 
see a crosshares.

2 Hold down CTRL key (You should see a “+” 
sign next to the cursor.) (Alt for Mac)

3 Drag the copied Window into position and 
release the mouse first.

4 To change the Scene, just right-click to 
show the drop-down menu to select a new 
Scene.

Hold CTRL (or alt for Mac)
Drag-Move to copy the Window

RIGHT - CLICK >
Select scene.

SketchUp 
Window

SketchUp 
Window
Copy

Below are some of the typical font and dimension sizes for an A3 size sheet.

COPYING A SKETCHUP WINDOW

SETTING OUT AN A3 SHEET

1

2

3

4

DRAWING PRODUCTION: LAYOUT
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SKETCHUP MODEL
LayOut’s Dialogues provide many powerful features. We’ve already gone through many of them but here are 

those not previously documented.

Raster mode is the fastest to 
render. It is recommended to 

maintain all SketchUp Scenes in 

Raster mode until all positioning 

and editing is complete.

8 Menu of all saved SketchUp 

Scenes in your model

9 Standard Views: Front, Back, 

Left, Right, Top, Isometric.

10 Model Scale

11 Pull-down menu: Render 
Modes: Raster/ Vector/ 
Hybrid

1 Choose Model View or 

Styles Selector

2 Ortho/ Perspective Toggle

3 Shadows On/ Off/ Date / 

Time of day settings.

4 Fog On/ Off

5 Fog Colour/ On/ Off.

6 Thickness of SketchUp 

Model lines.

7 Manual-Update/ Auto-

Update SketchUp model 

changes. (Note that Auto-

Rendering can slow down 

your LayOut file 

considerably. See notes 

below regarding render 

times.) Vector

Hybrid

1

2

3

4 5

6

7

8
9

10

11

Raster Vector Hybrid

Pure “Vector” mode mutes all 

materials so that only flat colours 

are visible. Translucency can’t be 

shown. Slow to render large 

models. Can be “exploded”.

Hybrid mode maintains textures 

while rendering the lines in Vector 

mode. Slow to render large 

models. Can be “exploded”.

Lines and Materials can be 
displayed in three separate 
“modes” Each mode has 

different advantages & 

disadvantages.

Guidance is given in the 

illustrations below.

“Pixellated” 

lines

Smooth 

lines

Smooth 

lines and 

“pixellated” 

materials.

DRAWING PRODUCTION: LAYOUT
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Clicking on the Scaled Drawing Dialogue activates the “Make a Scaled Drawing”  button. Clicking on this 
button opens a window that allows you to draw according to your chosen scale.

Draw to scale in LayOut:

1 Click on “Make Scaled Drawing” Button.
2 Choose Scale (For example 1 : 10), Length Type and Units. The various options are illustrated below.
3 Click on the Line tool.
4 Click on a start point and point your cursor in the direction you want to draw.
5 Type a number and hit “Enter”. The resulting line will be appropriately dimensioned.
6 Dimensions will automatically reflect scale.
7 The Join Tool binds together lines or curves whose endpoints meet.
8 The Split Tool breaks apart lines, curves or shapes into separate segments.
9 The Select tool enables positioning of lines but also enables editing of shapes by double-clicking.
10 Dimensions applied will reflect your scale automatically.
11 Lines and infills are edited as previously illustrated.
12 To finish, click Escape.
13 The drawing is a discrete Group. To edit, use Select Tool and double click.

SCALED 2D DRAWING

Inches
Feet
Millimeter
Centimeter
Meter

Decimal 
Architectural
Engineering
Fractional

15
0m
m

Select Tool:

Single-Click to select a line or 
shape.
Double-Click to edit a line or shape.

Line Tool/ Arc Tool:

Single-Click to start drawing a line or 
curve. Click each point as required.
(With Line tool- Drag as you draw to 
create curved lines.)

Join Tool:

This tool “joins” 
lines together.

Split Tool:

This tool “splits” lines 
into separate parts.

4

5

6

3

70mm

Style:

Line Colour, thickness, type is all controlled in the 
Shape Style Dialogue as previously documented.

7

8
9

Make Scaled Drawing

1:10 2

1

DRAWING PRODUCTION: LAYOUT
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The Dialogue contains:

1 The Sequence (Order) of Pages

2 Page Numbers

3 Page Names

4 Include in Presentation On/ Off

5 Add Page Button

6 Duplicate Page Button

7 Delete Page Button

8 Display as List Button

9 Display as Grid Button

PAGES & LAYERS

4

5 6 7 8 9

2 3

The Pages Dialogue displays the order of pages and provides an interface for naming them. The order 

of pages can be controlled by dragging and dropping. Page names and numbers can be used for “Auto-

Tagging” so that one tag can be used across multiple pages avoiding the need to individually number and 

name each sheet.

Denoting whether pages should be 

included in a presentation or not.

Features of the Layers Dialogue:

10 Current (Active) layer is denoted by 

the Pencil icon and the blue 

background.

11 Layer of any selected object is 

denoted by a blue square.

12 “Eye” icon denotes whether a layer 

is visible on a particular page.

13 Lock Icon “locks” a layer so that it 

can’t be edited.

14 The “shared layer” icon signifies 

layers that are visible across 

multiple pages.

The Layers Dialogue displays the order in which different elements are displayed. Those higher up in 

the sequence are “in front of” those lower down. The order can be changed by drag-drop.

Note: If you wish to have a layer displayed on every page 

but one, you can switch on the shared layer setting (14) 

and then switch off the “Eye” setting (12) for that page.

10

2

3 4 5

Add Page

Delete Page Page Name

1

11

12 13 14

DRAWING PRODUCTION: LAYOUT
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PLAN Scale 1/100

Perspective from West

Perspective from East

Plan/ Perspectives
Sheet Size: A3

Notes: Drawings are for 
Evaluation Purposes only.
Do not scale from drawing.

East Elevation

West Elevation South ElevationScale 1/100 Scale 1/100

Scale 1/100

Roof Plan Scale 1/100

Elevations
Sheet Size: A3

To create the Roof Plan Scene 
in SketchUp, just use one of 
your elevations as a starting 
point. Click on the “Top View” 
button to obtain the view and 
Create “Roof Plan” Scene.

Finishing the 
Sheets

Font: Avenir Medium, 20 Pt.

Font: Avenir Book, 14 Pt.

Font: Avenir Medium, 10 Pt.

SETTING OUT YOUR SHEETS

As we saw previously, drawings are 
inserted via:

File > Insert > (SketchUp File)

The SketchUp window is inserted.

To set up our Plan: 
Right-click on the SketchUp 
Window and select the Scene 
(Here it’s the “Plan_0” Scene that 
we created.)

Right-click again on the SketchUp 
Window and select the scale (1:100 
in this case.)

Drag the sides and corners of the 
window into position so you can 
see the whole drawing.

Drag on the model to position the 
SketchUp Window.

Holding down the CTRL key (or alt 
for Mac), drag the SketchUp 
Window to create a copy.

If you need to edit the Scene, go 
back to your SketchUp model by 
right-clicking on it and selecting 
“Open with SketchUp”.

You can then make changes to the 
model or create a new Style for that 
Scene. Remember:

1 In SU: Update the Style
2 In SU: Update the 

Scene
3 In SU: Save the 

SketchUp File
4 In LO: Right-click on the 

SketchUp Window and 
select “Update Model 
Reference”

Font: Avenir Medium, 24 Pt.

“Top View” button in SketchUp.

DRAWING PRODUCTION: LAYOUT



LayOut: Scrapbook Page
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Scrapbook is a kind of  LayOut “browser” which allows you to “click and drop” graphics from the window into 
your LayOut Page. Scrapbook contains lines, text, shapes, drawings of trees, cars, people arrows and many 
other things that you can use to instantly populate your drawings with information.

Scrapbook Window

001 

A 
001 

::  PROJECT TITLE 
scale: 1"=1' 

A 
001 

3
A3 N 

A
01 

DRAWING TITLE 
scale: 1"=1' 

1 Drop-down menu with sub-menus.
2 Graphics for selection.
3 Next Scrapbook Page/ Previous 

Scrapbook Page buttons.
4 Edit current “Page” (Opens this as a 

LayOut file.)
5 Click-Select and Click-Place objects.

1

2

3

4

Some of  the selection of  graphics available for insertion.

Select cars, trees and other graphics of various scales.

Scrapbooks contain both SketchUp files and simple line graphics.
They can be instantly updated to include your own content.
Select cars, trees and other graphics of various scales.

SCRAPBOOK

Click to Select 
and click to Drop

5

DRAWING PRODUCTION: LAYOUT



LayOut: Finishing Sheets 2 Page
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Previously we saw how to import, position and size our SketchUp files. (Refer to 
“Drawing Production” Page 103) Below we have the typical sizes and settings for an A3 
size drawing sheet at 1:50 size.

THE SECTION SHEET

Font: Avenir, 
Heavy, 18pt.

Shape Settings:
Fill- On.
Stroke Colour: Black.
Stroke Thickness: 1 Pt.
Pattern:“Brick Common Face” (Scale 0.25)

20 Point Arial Unicode MS28 Point Arial Unicode MS

Triangles: 
Polygon: “3s”
Radius: 8mm
Stroke: 2Pt

DRAWING PRODUCTION: LAYOUT



LayOut Details Page
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double 
- CLICK

RIGHT - 
CLICK - 
select
scale

SET UP THE DETAILS LAYOUT SHEET

2

4

1

5

3

LAYOUT DETAILS

10 Point Arial Unicode MS

6mm Dia. Circle 1Pt. Stroke

14 Point Arial Unicode MS

20 Point 
Arial 
Unicode 
MS

28 Point Arial Unicode MS

“Perspective” Scene

“Section” Scene

Below is the Details Sheet showing the recommended sizes of Text Fonts, Scenes 

and graphics. Let’s Insert our SketchUp File Scenes: “Perspective” and “Section”.

Go to: File > Insert [The Details Model File].
The SketchUp window should appear.

Right-click on the SketchUp window and select the “Perspective” Scene.

Using Shift-Drag, Copy the SketchUp window then right-click to select the 

“Section” Scene.

Position and size your window as follows   (We won’t set the Scale just yet)

1 Drag the window into position at top-left.

2 Drag the bottom-right corner across to fill the intended area. 

3 Once you have the size you want, you can freeze the Scale in the 

SketchUp Model Dialogue to implement the Window size.

4 To adjust the scale and position of the Perspective: Double-click 

into the window and use your mouse to zoom and pan (Use the 

same controls that are used for SketchUp.)

5 To scale the Section scene, right click on it and select “1/20 Scale”

In the SketchUp Model 
Window, the “Preserve Scale 
on Resize” tickbox allows you 

to resize the model using the 

model Window size, or to 

freeze the scale.



Modelling - FinishUp Page
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Congratulations! Completing this course successfully means you’re now able to 
produce professional documents in SketchUp Pro.

If you have any questions, please don’t hesitate to get in touch- paul@sketchup.expert or 
visit sketchup.expert for more information about training and advice.

Sign up for exclusive offers for future training products and material & model 
downloads. Visit sketchup.expert and click on the Resources Page.

Thanks for buying my book!

I’ll be adding features to the website with freebies and downloads. 
Make sure to sign up with the word “SketchUp Constructor” in the 
message or email header for exclusive access. 
Also, join the discussion thread about SketchUp for Construction & 
Working Drawings Discussion in SketchUcation here: 
https://sketchucation.com/forums/viewtopic.php?f=12&t=15911

MODELLING THE HOUSE: FINISHUP

mailto:paul@sketchup.expert
https://sketchucation.com/forums/viewtopic.php?f=12&t=15911
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THIS BOOK IS AIMED AT INTERMEDIATE TO ADVANCED USERS. IT IS BEST TO FAMILIARISE YOURSELF WITH BASIC MODELLING AND NAVIGATION BEFORE PROCEEDING WITH THE EXERCISES CONTAINED INSIDE.

Background Image of Calatrava Architecture by extrabrandt via Pixabay.com

SketchUp is the de-facto replacement for 2D CAD. Author Paul Lee 

believes that 2D CAD was in many ways a step backwards from the drawing 

board where all information was visually accessible.

The use of computers in the production of drawings has only become truly 

advantageous with the advent of tools such as SketchUp where once more 

all information is visually available in one glance. The advantages of using a 

3D model as a single reference point are too numerous to mention.

The SketchUp model has become a means of “Building The 

Information” where the model itself contains much of our project data- 

Not just in relation to dimensions and textures but for itemising and 

cataloguing components/ materials/ volumes; For facilitating future 

revisions; For carrying out functions such as cost analysis, energy 

analysis, construction sequencing and many more.

Gone are the days of the single-function drawing which requires 

manual coordination with other drawings. Drawings are now auto-

generated from the 3D model and errors are effectively eliminated.
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